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1 INTRODUCTION

Released in 2009, Plan-G was the first Flight Simulator planning software tool to use
the acclaimed and versatile Google Maps mapping tool. Hitherto, the inbuilt planner
and third party external flight planners have extrapolated geographic data from the
Simulator program itself, with the limitation which that entails. Plan-G was instantly
popular and widely acclaimed across the flight simulator enthusiast world, and in
September 2011 won the prestigious Mutley’s Hangar Award for Flight Simulator
Addon excellence.

Using a public domain global map Plan-G overlays features pertinent to Flight and
Flight Planning — Airports, Controlled Airspace, Prohibited and Restricted Areas,
Instrument Approach Paths and many more.

Flight Plans can be graphically modified; adding, deleting or dragging waypoints to new
positions with the mouse. User defined waypoints can be created “on the fly” as you
build a plan.

Plan-G Version 3 is a brand new, completely revised version, and now uses Open
Street Maps as its mapping base. Although terrain modelling and shading is not
currently available in OSM, the vertical terrain profile feature in Plan-G-v2 has been
enhanced and simplified to provide the same vertical navigation planning capability.

The several information panes are now presented as floating windows, allowing the
user to place information anywhere on the screen, or not, as they wish.

Many new features have been added to Version 3 to make Plan-Gv3 the essential
Flightsimmers utility application. As well as working with FS9 and FSX, Plan-Gv3 now
interfaces with X-Plane, and with VATSIM if the user is connected to the Internet.

To avoid complicating the text unnecessarily, where the words “Flight Simulator”
appear in the text, X-Plane is included unless there is a specific difference between the
behaviour of the Microsoft product and X-Plane, which is explained separately.

New features include: creating separate aircraft performance profiles, “Quick” flight
plans, IFR flight plans, local KML & KMZ, bookmarking particular map views and a
unique Radio Stack which simplifies changing frequencies, especially if Plan-G is run on
a separate display to FS or X-Plane.
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2.2

FEATURES

Features Retained from Version 2

Supports FS9 and FSX.
Shows airspace, airports and radio navaids on the map (from Flight Sim data).
Configurable levels of detail (objects displayed) for each zoom setting.

Vertical Navigation profile (requires additional Digital Elevation Model (DEM)
download).

Fully editable flight plans can be saved in FSX or FS9 format (.pIn), or in Plan-G’s
own format (.plg).

Existing FS plans and Plan-Gv2 plans can be loaded and edited if required.
Flight plans can be reversed at the click of the mouse.

Flight Plans can be annotated, and waypoints cross-referenced to ground-based
radio navaids.

Either map or Pilot’s Log (PLOG), or both, can be printed.

Customisable database of user waypoints, Visual Reference Points (VRPs), airstrips
etc. Many useful waypoints are included in the download. Multiple user
databases can be built if required.

Additional User Waypoint comma separated text files can be imported.

Can be run on a second monitor or on a networked PC across a local area network
(LAN).

Synchronised connection to FSX or FS9 either on the same computer or across a
LAN.

Aircraft telemetry, aircraft flight trails, traffic, weather etc available when
connected to FSX or FS9.

Saved flight trails can be displayed for later analysis.
Configurable Range Rings can show distance or flight time.
Display instrument approaches and low altitude airways.

Display current weather for known weather stations in TAF and METAR format
even if not connected to FS.

New Features in Version 3

OpenStreetMaps interface (replaces Google Maps) for comprehensive
topographical detail including railways (traditional VFR navaid) woodland, parkland
and watercourses.

“Snippets” - multiple waypoints which can be inserted into a plan either by “quick”
entry” or from a snippets format (.snip) file.

Now supports X-Plane Versions 9 & 10. Fully editable flight plans can be saved in
the X-Plane format (.fms), or in Plan-G’s own format (.plg).

VATSIM Support — show all VATSIM controllers and active pilots on the map.
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e RADIAL menu allows you to click on multiple VORs or NDBs and display specified
radials from them for easy identification of intersections.

e A COM/NAV Radio Stack which simplifies changing frequencies, especially if Plan-G
is run on a separate display to FS or X-Plane.

e Additional options added to the main map context menu.
e KML (& KMZ) files can now be stored on your PC.
e Revised Elevation Plot display.

e Aircraft Performance Profiles. Can your chosen aircraft fly at the cruising airspeed
or altitude you have set?

e Data Tools allow data to be moved between MSFS and X-Plane databases.

e PDF Charts display. Copy your airport charts, approach plates etc into (e.g.) Plan-G
Files\Charts\EGKB and they will automatically be available when you right click the
EGKB airport.
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3 PREREQUISITES

To function, Plan-G requires that .Net 4.0 Client Profile be installed on the user’s PC. If
it isn't installed on your PC, it is downloaded automatically by the installation program,
and the user doesn’t need to take any action.

Plan-G requires an active Internet connection to display the OSM Map base and
update it correctly.

An Internet connection also allows VATSIM traffic and controllers to be displayed
when the ‘VATSIM’ option on the Home ribbon is selected.

Page 4 of 128



Plan G User Manual V 3-1.061 October 2012

4.2

4.3

4.4

INSTALLATION

The Download

Download the latest version from the TA Software Forum
http://www.tasoftware.co.uk/forum. Unzip the downloaded zip file to a temporary
folder of your choice. Three files will be extracted:

e setup.exe,

e Setup.msiand

e ReadMe.txt.

Windows XP

Installing Plan-Gv3 is straightforward. Double-click setup.exe and the installtion will
commence.

Windows Vista and Windows 7

If installing under Windows Vista and Windows 7, the person installing Plan-G must

have Administrator privileges. This means either

e Having an Adminstrator account on the computer, in which case, double-clicking
‘setup.exe will start installation, or,

e Obtaining temporary Administrator privileges by right clicking on ‘Setup.exe’
selecting “Run as Administrator”. Installation will then commence.

Installation

The setup window opens with a window containing a copyright notice. Click the ‘Next’
button to open a window containing a dialogue box in which to enter the folder into
which you wish to install Plan-G. The default locations depend on your operating
system.

In a 32 bit Windows system, the default is a folder within the standard Program Files
system of Windows, normally:

C:\Program Files\TA Software\Plan-Gv3
For 64 bit systems, the default is a folder in Program Files (x86), normally:
C:\Program Files (x86)\TA Software\Plan-Gv3

Some people have problems with file access permissions when installing in these
default locations, especially with Windows Vista and Windows 7. If you would prefer
to install Plan-G outside these secure areas of your file system, you may. Simple click
the “Browse” button and navigate to the folder in which you wish to install Plan-G, for
example:

C:\Users\John Doe\Aviation\Flight Simulation\Plan-Gv3

You can install Plan-G for everyone that uses the computer on which it is being
installed, or just yourself, the person installing it. You can also check the amount of
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4.5

disk space needed. When you then click the ‘Next’ button, following an “Are you
sure?” confirmation screen, on which you again click the ‘Next’ button, installation will
then proceed rapidly.

The installer will place a small yellow aeroplane symbol on your desktop which is the
shortcut to start the program. Move it somewhere convenient if you wish. That is
installation complete.
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Figure 1 The Plan-G User Interface at First Startup

If you have installed earlier versions of Plan G3, you can either delete the previous
contents of your Plan-G folder completely, or you can if you wish leave the files, and
the unzip routine will overwrite the files which have been added or changed.

The Data

Plan-G3 stores all its database files in a folder called “Plan-G Files” within your “My
Documents” Folder. This makes it easy to maintain backups and other housekeeping
tasks. If you have created user waypoints in an earlier version of Plan-G that you want
to keep, they will be stored in this folder, either in the file UserWpts3.sdf, or in your
own user-defined file in comma separated value (CSV) format.

Useful Tip: Why not keep a backup of your User Waypoints as a CSV file anyway, in a
separate folder from Plan-G to avoid it being accidentally overwritten when you install
a new version? You could make it part of your normal backup routine, which of course
you have!

With each new version, you will need to rebuild the main database. A warning
message to this effect appears when you first start Plan-G. Many other settings are
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also reset in each new version such as the locations of the important FSX files Plan-G
needs to access, (See Section 8.7.1 for details).

If you uninstall Plan-Gv3, all your user data and your database remain in
Documents\Plan-G Files and are unaffected. You can also delete the database files any
time you wish as long as Plan-G is not actually running - it will recreate them next time
it runs. Of course you will need to run the ‘Build Navigation Database’ option from
the ‘Data’ tab again to populate the database.
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5.1

5.2

5.3

FIRST RUN

The first time you run Plan-G it opens with a map view centred on Enstone Airfield in
the UK. In addition the Flight Plan Window and the Information Window are open.
They can be closed by clicking the relevant icon on the ‘View’ ribbon, or you can move
them to one side of the map view if there is space on your screen. The ‘Data’ ribbon is
open by default which includes a tab which prompts you to build the Plan-G internal
database before doing anything else. Once the database has been created you can
explore at leisure.

Single PC

To build the internal database with Plan-G and a Flight Simulator on the same
computer, go to the Data menu and click on the Build Navigation Database icon. You
may then select the Flight Simulators for which you want to build databases. You can
build databases for any one, two or all three. Once they have been built, you can
switch between them and Plan-G will load the correct dataset.

R ] ) First Plan-G3 (v30.032) [ =) B i
r— . - @
[ Please generate a database for F5X or F59. Click on the Build Database button af left. If the

#N button is not enabled, use the options dialog (small button below if) to set the FS locations.

Figure 2 Database Build Options

Networked PCs -MSFS

If FSX or FS9 is installed on a separate, networked, computer to Plan-G, you must first
follow the instructions in Section 8.7.1 below to set up the locations in Plan-G so that it
knows where to get its Flight Simulator data. Once you have done this, Plan-G will be
able to find the data it needs to build the database for the appropriate sim. You can
even have FSX on one PC, FS9 on another, and Plan-G on a third. Aslong as the
locations are set correctly, Plan-G will build the databases.

Building the databases is not the same as connecting Plan-G to your sim. To connect
FS to Plan-G follow the instructions in section 19 - “Flight Simulator and Plan-G on
Separate Computers”. However, you must have first set the locations otherwise when
you try to connect FS to Plan-G, you will get an error message.

You may find it simpler to install an extra copy of Plan-G on your Flight Simulator PC
and build the database(s) there. You can then copy the Plan-G Files\Data folder across
to your networked PC.

Networked PCs - X-Plane

First ensure that the folder containing X-Plane.exe is shared. Then set the location of
X-Plane.exe on the Plan-G computer. There is no equivalent to scenery.cfg in X-Plane,
so you don’t need to enter anything else. Full details are given in Section 19.5.

You may find it simpler to install an extra copy of Plan-G on your X-Plane PC and build
the database there. You can then copy the Plan-G Files\Data folder across to your
networked PC.
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54 Has it Worked?
Occasionally Plan-G will appear to build the database very quickly. This usually means
that the build has failed, and you will have to build the database again. You can
quickly check whether a database exists, because the icon for any databases not
available are disabled and greyed out. If a database is installed, then when you move
the mouse over it’s icon, it will display an orange background (see Figure 2 above).
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6 HAVE A LOOK AROUND

Most of the screen is occupied by a map. If you have used online maps before, moving
around the map — panning across the landscape and zooming to different
magnifications will be quite familiar. The level of detail changes at different zoom
levels — both the basic map features and the flight related overlays. The latter are user
configurable (See Section 10.1).

The second dominant feature is the menu ribbon at the top of the Plan-G window.
There are four ribbon menus: - Home, Map, Data and View. The Ribbon menu icons
will change size and position if the main window size is changed, although they stay in
the same logical part of the ribbon and sequence to avoid any confusion. The menu
ribbon may contain scroll bars at the ends if the window if the Plan-G window is
contracted in width to less than the minimum length of the ribbon.

s Plan-G3 fv 3.0.0.38) = | B |t
Home. Map Data View @
[ Large [ Helipads = vors [ IsEc [Z] ICAC Airspace ] RDPM Airspace CI' €33 Airstrip | bisused | [¥7 pot |0 slider |
[Z] Medium [T FloatPlane Bases ne/oc [/ NbBs [0 ISEC (unnamed) [ Centre [7] Special Use i |(Fis Helipad | @ Location || © vro | user1 |
[&] Small ] Farm Strips [T Lower Airways Colour Guide || Water | | A obstacle | & 1R |0 userz |
Airparts Navaids Airspace User Waypoints

Figure 3 The Menu Ribbon for the Map Tab
= Plan-G3 (v3.0.0.33) o | (e

Map Data View [~}

Home

[# vors [ IsEC [¥] ICAO Airspace [ RDPM Airspace |€73 airstrip |
[#] NDBs [[] ISEC (unnamed) | [ Centre [] Special Use |
L5106 - Airspace ‘

4] Farm Strips [ Lower Airways Colour Guide @ water | |

Airports Navaids Airspace
~ =

Figure 4 Menu Ribbon Scroll Bars

6.1 The Quick Access Toolbar

By default, this toolbar contains three items. However, ANY button on any of the
ribbons can be added to the Quick Access Toolbar by right-clicking and selecting 'Add
to Quick Access Toolbar'.

Map View

(= |
A 1T @ A ~ 5=
B e
Start  AMifude Airspeed Winds Aircraft
Position Profile

Find Flight Plan

Figure 5 Quick Access Toolbar
The default icons are, from the left:

The “Yellow Aeroplane” icon — moves, resizes, minimises or maximises the whole Plan-
G window.

The “Blank Page” icon — clears any elements of a flight plan in memory, allowing a
fresh start.

The “File Open” icon — opens the ‘My Documents\Plan-G Files’ folder, allowing
selection and display of an existing Flight Plan file
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6.2

The “File Save” icon — opens the ‘My Documents\Plan-G Files’ folder, allowing the
currently open Flight Plan to be saved.

The “Down Arrow” Icon — clicking this icon displays a small dropdown menu with six
options. In the picture below, an additional option, Save Flight Plan has been selected
as well as the default, and the relevant icon is shown on the Quick Access Toolbar.

g W T
Ha Customire Quick Access Toolbar | View
W | MNew Flight Plan 5i VFR |
. -
™

/| Open Flight Plan . [y
V| save Flight Plan e

Find Start)
Positic file
Print Map ight Plan

Print Flight Plan

Find

Show Below the Ribbon Blék.wul

Figure 6 The ‘Customise Quick Access Toolbar’ Dropdown

In addition to the five Quick Access Toolbar options, the Quick Access Toolbar itself
can be shown below the ribbon rather than above it. When the Quick Access Toolbar
is below the ribbon, the final item on the dropdown changes to “Show above the
Ribbon”, as you might expect.

The menu ribbon can be hidden by double clicking on one of the four ribbon tabs
(“Home”, “Map”, “Data” & “View”). To restore the ribbon, double click again any of
the ribbon tabs.

The ribbons can also be “auto-hidden”. At the far right hand end of each screen,
above the ribbon and next to the question mark ‘Help’ icon, is a small up-arrow icon
which hides the ribbon when clicked. The up-arrow then changes to a down-arrow.
When the ribbon is hidden, if you click on the down-arrow icon, the ribbon is again
displayed. Double clicking any one of the Menu tabs has the same effect.

When the ribbon is “auto-hidden”, if you click one of the Menu tabs once only, the
relevant ribbon for that tab opens temporarily for further user action. If you click
away from the ribbon — on the map or window border — the ribbon is again hidden.

The menu ribbon functions are not needed at all times, so minimizing the ribbon does
not necessarily reduce your options, but can free valuable screen space.

The “File” tab is a special case. Clicking once only opens the File screen. Clicking once
only again closes it. In this and in other ways, it functions differently from the other
tabs.

The Ribbon Menu Tabs

There are five Tabs, each of which when clicked, reveals its own Ribbon Menu (except
“File” which opens a page with a sidebar menu).

Home. Map Data View
[#] Large [ Helipads “& )

[] Medium [ FloatPlane Bases ‘

...... IL5/LOC Filter

[] Small Airports~>
Airports

Figure 7 The Menu Tabs

Page 11 of 128



Plan G User Manual

V 3-1.061 October 2012

6.3

6.4

The ribbon menus control almost all the functions of Plan-G.

The Main Window

When Plan-G starts, the main window displays the map location where you were when
you last exited the program, and at the same magnification. Features are displayed in
accordance with the user-defined options on the Map ribbon.

The Pop-up Windows

When the main View tab is selected, the ribbon shows a row of ten icons which are
links to ten floating pop-up windows. They can be opened, closed, resized and moved
as the user prefers. Each of these windows covers one of the following topics: -

e Plan:

e Plan Elevation

e Information:

e Aerodrome:

e Weather:

e Trail Analysis:

e PFD:

e Radios

e Traffic

e VATSIM

The tabular Flight Plan itself,

The terrain profile and vertical navigation profile if the
requisite Digital Elevation Model (DEM) files have been
downloaded and installed.

Displays textual data about controlled airspace and other
details.

If you right-click an airport on the map and select “Show
Airport Chart” from the drop-down. The aerodrome chart,
runways and taxiways is displayed beneath the Aerodrome
tag.

When connected to FS shows the FS weather for the nearest
weather station to the aircraft, and the en route weather. This
FS weather may of course be external real weather, depending
on the source being used by FS itself.

Displays a vertical profile of the currently selected trail shown
on the main map,

Displays five of the standard “six-pack” flight instruments
which are fitted directly in front of the pilot in most modern
aircraft before the advent of “glass cockpits”. The missing one
is the Attitude indicator.

Displays a conventional NAV/COM Radio Stack window as
found in most aircraft which can be used instead of the
aircraft’s own radio stack if preferred.

Displays on the main map a small red aircraft symbol for any
aircraft which satisfies the display criteria set on the
Files/Options/Traffic page.

Opens a window which lists all Air Traffic Controllers and Pilots
currently connected to VATSIM in alphabetical order by call
sign.

The default view at startup displays the Plan and Information windows, and after the
initial startup, i.e. once the database has been built, the ribbon associated with the
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Home tab. The function of each of these optional windows is described fully in Section
12.

6.5 Tool Tips
If you hover the mouse over any symbol, menu option, tick box, radio button or
aeronautical feature on the map, a context sensitive tooltip is displayed briefly
describing the item’s function or identity. Of course, many are obvious, but it
surprising how useful they can be when your mind goes blank (as it will sometimes,
fear not!).
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v

7.1

7.2

7.3

THE RIBBON MENU TABS

The File Tab
B — If you click the “File” tab, then the map
T view closes and a new view opens
e | - containing several file handling and
B = oo 2%  setup options shown as a menu on the
: , Rror® #%x  |eft hand side of the page.
.};' S s %=  Thedefault view is of the Recent option
::“ B, o e et %  from the left hand menu, with, on the
R S et i #/x  right, a list of ten of the most recent
B e ix flight plans opened. The left hand
Bl i #/x/  menu options are described fully in
B Sty #%  Section 8 below.
g@_i VPRt Msodows 1o Mchiride plg | %

Figure 8 The File Menu Page

A pushpin icon on the right of each of the ten most recent flight plans allows the
selected flight plan to remain in the Recent files list while other flight plans may
change as new flights are created. All ten can be selected to be pinned if desired. A
red cross icon will delete that entry from the list, but it does not delete the flight plan
itself.

The Home Tab

Selecting the Home Tab displays the Home ribbon, which contains a significant number
of options described fully in section 9 below.

L A s Plan-G3 (v 3.0.0.34)

Dat View [~
f ERE 3 0
II./_A.%“"F“B—I'QJ\G @@E S5 @
Hmw : @ | El) B svne |
Start Altitude Airspeed Winds Aircraft Quick Re Fr Copy Bookmark KML Connect Disconnect VATSIM
Position profile Route | |OneRing v -+ Free
Find Fiight Plan Range Rings Ot Fiight Simulator

Figure 9 The Home Ribbon

The Map Tab

Selecting the Map Tab displays the Map ribbon, which shows the items which are
displayed as standard at each scale (level of zoom) of the map. It is user configurable,
but the more detail displayed at the lower zoom levels (more map displayed) the more
cluttered the display will be and the slower to load and refresh following changes. If
the user selects too much data to be displayed, Plan-G can sometimes display an error
message.

[ Plan-G3 (v3.0.0.34) =en X
Home Map Dafa View & @
[ Large  [OJ] Helipads i 3 [ vors [ ISEC "/ [#] ICAO Airspace [[]] RDPM Airspace CD 'C} Airstrip |® Disused H\:{ POL ln Slider | ‘
Medium ] FloatPlane Bases NBBs [ TSEC (unnamed) [] €entre. [C] Special Use ) Helipsd |l@ Location | & vep | usert |
ILS/LOC | Filter Filter Airspace | T ! " | Filn
Small et [l Lower Airways ' ngvaids~ Colour Guide || Water | | 4 Obstacle | & TR [CJ userz | waypo
Airports Navaids Airspace User Waypoints

Figure 10 The Map Ribbon
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7.4

7.5

7.6

The map settings are described in more detail in section 10.

The Data Tab
The Data Tab displays the Data Ribbon which allows you to

e C(Create the database for either FS9, FSX or X-Plane, and

e Select which simulator’s data displays on the map and for which you wish to create
a plan.

e Manage the User Waypoint database.

These options are of course only available for the simulator version(s) you have
installed.

Any current databases available are indicated by the relevant icon being a strong
colour. The icons for databases which have not been installed are greyed out. If you
pass the mouse over the icon for an installed database, that icon is displayed with an
orange background. The icons are the same as those used for the programs they
represent.

Plan-G3 {v3.0.0.34) = | B ||

74

FN
bata Manage
aols

(]

User Waypaints

Figure 11 Data Ribbon

Further details of how to use these options is given in section 11 below.

The View Tab

The view tab displays options to customize some elements of what you see on screen.
Map overlays and the map graticule can be switched off to improve clarity and speed
map refresh rate, for example. There are also three customisable fixed zoom buttons
for quickly selecting a favourite zoom ratio. The ten icons commencing with ‘Plan’ on
the left and ending with ‘VATSIM’ on the right each enable a pop-up data window.
These are resizeable with the exception of the Radio Stack and the PFD Windows.

o= | A= Plan-G3 {v3.0.0.34) o ) | S
Hame. Map Dbata View o Q
o E1 [l [0 & B E GIHF@ AT, #
=l =F 0 & = [N (@ S TIE.
Plan  Plan  Information Aerodrome Weather Trall  PFD Radios Traffic VATSIM Zoom Zoom Keep
Elevation Analysis out n 12 onTop
Show / Hide Cantral Zoom window

Figure 12 The View Ribbon

Ribbon Auto-Hide

At the far right hand end of each ribbon is a small caret icon which when clicked hides
the ribbon (whichever ribbon you are viewing at the time). It hides the whole ribbon
system, not just the one you are currently viewing. When you click one of the Menu
tabs, the associated ribbon is displayed until you click on the map or window border,
when it is automatically hidden again. Alternatively, the hot key combination, Ctrl-F1,
toggles hidden or displayed mode.

If Auto-hide is enabled, The ribbon is “auto-hidden” in this way on first installation.
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VATSIM

Minimize the Ribbon (Ctrl + F1)
Show or hide the Ribbon
Rhayader, When the Ribbon is hidden, only

the tab names are shown
Llandrii N

Figure 13 The ‘Minimise the Ribbon’ icon and Tooltip

Double-clicking any of the tabs (except the File tab) will also auto-hide the ribbon.
Double-clicking a tab again will display the relevant ribbon and switch off the auto-
hide feature.
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8.1

8.2

THE FILE MENU IN DETAIL

The File Menu isn’t a ribbon, but a page with a vertical sidebar menu. The page
default function is to display the last ten flight plans created or opened. A pushpin
icon on the right of each of these ten most recent flight plans allows the selected flight
plan to remain in the Recent files list while other flight plans may change as new flights
are created. All ten can be selected to be pinned if desired. A red cross icon will
delete that entry from the list, but it does not delete the flight plan itself.

New Plan

Selecting “New Plan” closes the menu and returns the user to the main map window,
where a new plan can be created as described in Section 14 below.

Open

Selecting the “open” option opens the Windows folder which contains all the Plan-G
data. By default, this is the Plan-G Files folder, located in “My Documents” (Windows
XP) or simply “Documents” in Windows Vista or Windows 7. The user can select a
flight plan from the list, or open a Trail file by opening the ‘Trail’ folder and selecting
one of the trail file options from the file type selection dropdown at the bottom right
of the window. The file type selection dropdown includes options for Plan-G (.PLG)
flight plans (the default), Flight Simulator flight plan files, (.PLN), X-Plane flight plans
(.FMS); Plan-G Version 3 Trail files (.JGC) and Plan-G version 2 Trail files (.txt).

ri_! Open ’ e . - vete . &]
@v*ﬂ . v User » Documents » Plan-G Files » - | Jv.’l | Search Plan-G Files 2 [
Organize = MNew folder B= v [ Ec}l
| Dropbox & Name Date medified Type Size
1=l Recent Places :
) . Data 21-04-12 00:19 File folder
. Trail 28-04-12 23:02 File folder |
Bl Desktop . . .
RN vatsim 28-04-12 21:52 File folder
= Libraries e .
- s WX 02-05-1217:09 File folder
j Documents - . : ,
j o || CIX Manchester te Blackpoel.plg 26-04-12 21:46 PLG File 3
- [] Cix Ocean Reef Club to Chalk's Key West.plg 25.01-1215:20 PLG File 4K
k| Pictures . B - )
= || Cix Opa Locka to btepec.plg 08-03-12 00:56 PLG File 6
)| Pilot Pete . ~ .
E = || Cix Pepham to Perranporth.plg 21-03-12 21:21 PLG File 2
ideos
|| C¥APlaya De Oro Intl te Ua-Huka.plg 14-12-1113:46 PLG File 3K
#& Homegroup . )
|| CXA Teterboro te Martha's Vineyard.plg 04-03-12 21:45 PLG File 2
2 Josh (JOSH-PC’
A Peter Dodds
1M Computer * wm = - :
File name: - [Plan G Flight plan flla(‘*plg) =2
%-Plane FMSfIlght plan files ( fms)

v3 Aircraft Breadcrumb Trail files (*1GC)
. v2 Aircraft Breadcrumb Trail files (* .t}

Figure 14 The File Open Window and Options

If you store flight plans or other data files at some other location, you can navigate the
file browser there, using the usual Windows methods depending on your Operating
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8.3

8.4

System. Plan-G "remembers" where you saved the most recent saved flight plans,
and will open the file browser at that folder, so you can select a previously created
flight plan from there.

Once the flight plan is loaded, Plan-G will change its map location and display the legs
and the waypoints of the whole of your selected flight plan.

Save As

The “Save As” option allows you to save the plan as a Plan-G extended flight plan
format (.plg) file, or to save a plan with a different name. However, Plan-G format files
cannot be used in the FS Flight Planner or the built in FS/Garmin GPS units.

Note: If your PC or Plan-G crashes, Plan-G remembers the flight plan you are working
on, and will automatically reload the plan (including any unsaved changes) when you
restart Plan-G.

Export

The “Export” option allows you to choose whether to save the plan as an FSX flight
plan which FS can use in it’s Flight Planner and GPS (.pIn file); an FS9 flight plan (.pIn
file); as an X-Plane 9 or 10 Flight Plan (.FMS) or as a Plan-G plan “snippet” (.snip) file, or
to save a plan with a different name. Snippet files are typically a short flight plans
containing two or three consecutive waypoints which, if saved as type .snip, can be
inserted into other flight plans. (See Section 14.3.6 for details of how to use snippets).
Plan-G specific features (passing altitudes, notes, cross-references etc) are not saved in
.PLN files. You must use ‘Save as’ and save your plan as a .PLG if you wish to preserve
this extra information.

Note: that the FS9 flight planning tool treats user waypoints as intersections.
Although user waypoints can be added to FS9 flight plans in Plan-G, they cannot be
added directly to a flight plan within FS9.

| =1l Flan)

File Hore. Map Data View
| !
New Plan Select file type
J. Open
L Save As Flight Simulator X Flightplan - export
Recent E-s
B Flight Simulator 2004 Flightplan - export
print FS
Help
X-Plane 9/10 FMS Flightplan - export
Options Es
B3 Exit
Plan-& Plan Snippet - export

Figure 15 The Flight Plan Export Options
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8.5

8.6

Print

There are three print options in all, though only two are shown on this screen: - to
print the map or the flight plan. Each selectable option includes a description. When
you select an option, the preview is displayed with a series of small icons at the top of
the print preview window to set the page parameters before printing, e.g. whole page;
page width etc. Each icon has a tooltip, so you can quickly select which one you need.
You can of course print both map and flight plan, and they print sequentially. Once
the options have been set, clicking the small printer icon will open the familiar
Windows Print window, so you can select all the usual options — portrait/landscape;
colour/greyscale; bordered/borderless etc. Clicking the “Print” button in that window
will start the printout.

If no flight plan has been loaded or newly created, the “Flightplan” print button is
greyed out.

o= | % . - Plan-G3: VFR Rand to Warmbaths =
File LY Man bata View - @
MewPlan | Ppint e @ B EAEH
). Open ‘
ki save As

Flight Plan: Rand (FAGM) to Warmbaths (FAWA)

Page 1
Recent

Export

Help

True Airspeed = 100 Kts. wind from 000° at 0 kts
Suggested Altitude = 2000 ft

Print Flight Plan
@, Previews the current flightplan
™ Click the prinfer buttan on the preview fo print.

Waypoint Dist. Al.  G/Spd Track  Heading Time ETA ATA

o ke TueMeg  Megratc  bhmm
(hER)

FAGM  Rand

Ot FACR Carletonville 43.8 e 100 z80°/277° 2779 0:26

& Exit FARG Rustenburg 433 = 100 355%/012° (Q12° 0:26

PNy PILANESBERG (1126 17.6 100 330%/346° 346° 0:11
2= wm MHZ)

FAWA  Warmbaths 70.5

100 ©0se%/082° (82°  0:42
Totals: L 1l

"~ |[ofBecks  |[Teeort | [ndieg | [OnSeoe |

Departure airport information Arrival airport information
Elevari 5432 fr. 3638 fr.
11/29 1713m x 15m Asphalt 03/21 1200m x 23m Tarmac

Johznnesburg Radar 124,500 MHz
Rand 118.700 MHz

Printed by Plan-G Not for operational use [+

Type text ta find s

Figure 16 Print Options

The third print option is available if the Plan Elevation Window is opened. At the top
right of the window is a small printer icon, which when clicked prints the Plan
Elevation Window exactly as displayed on screen. Again, the conventional Windows
Print window opens first, so you can select all the usual options — portrait/landscape;
colour/greyscale; bordered/borderless etc.

Help

The help Page provides four options: -
About Plan-G provides information about the current build of the program.

User Manual opens the Adobe Acrobat format Plan-G User Manual (this document).

Page 19 of 128



Plan G User Manual V 3-1.061 October 2012

8.7

8.7.1

Technical Support is a link to the TA Software forum, where all the experts, including
Tim Arnot, the Plan-G creator, are ready and eager to solve your problem.

Check for Updates will automatically check for updates to your currently installed
version.

Options

Selecting “Options” opens an Options window, with a second sidebar menu which
gives access to nine different dialogue panes. When you open Plan-G, the first time
you visit the “File/Options” menu selection, the right hand area of the page is blank,
and remains so, unless you select one of the nine options. Plan-G keeps open the last
selected pane for the duration of the Plan-G session.

The options panes are reasonably self explanatory. Default values are included which
can help decide appropriate values.

You may not wish to change the defaults, but when things get busy, for example, you
can de-clutter the screen by selecting the ‘Traffic’ option and switching off Al, or
parked aircraft, or limit the range within which they are shown. If you want to see
your own aircraft when Plan-G is connected to Flight Simulator you clearly have to
have the first box ticked in “User Aircraft”, but there may be occasions when you only
want to see everyone else. This element of Plan-G allows you to choose. Of course
these options only apply to Plan-G itself. What you see in your Flight Simulator is
unaffected by these selections.

The nine options are: -
e locations

e Units

e Sounds

e FS Connections

e GPS Panel

e User Aircraft
e Traffic

e Weather

e General

The options are described in detail below.

Locations

The Locations menu option allows Plan-G to locate the FS files it requires in order to
build its internal database of airports and navaids, and to communicate with a running
instance of Flight Simulator on either the same computer or a networked PC running
FS.

A) Single Computer — FS9 & FSX
The two directories Plan-G needs to “know about” are:
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The main Flight Simulator directory, which, by default, is C:\Program Files\Microsoft
Games), but this is often changed by users during FS installation, (e.g. E:\FSX as shown
in Figure 17 below).

The directory containing FS's scenery configuration file (scenery.cfg).

For Windows XP users, this is usually

C:\Documents and Settings\<user name>\Application Data\Microsoft\FSX
For Windows Vista and Windows 7 users, this is usually

C:\Program Data\Microsoft\FSX.

In most cases, these directories will be in these “default” locations, and Plan-G will be
able to automatically locate the correct location, but if your FS installation differs from
the default, you may need to point Plan-G at the correct locations on your FS PC.

Plan-G3 (v 3.0.0.34]

Export

F5 Connection

X-Plane:

Print

vielp

PS5 Panel Additional Scenery Locations:

I
i Ao
s
New Plan Select Option Locations
]
#i Open | Locations FSXPragram: | E:\FSX Browse.. |
Save As
Units FSX Scenery.cfg: Browse... ‘
Recent —
Sounds F52004: Browse.. |

User Aircraft

Traffic

[ Locations

Units

User Aircraft
Traffic
Weather

General

FSX Program: CNFSX

FSX Scenery.cfg:

B3 Exit Weather
Seneral
Add... |
Figure 17 The Locations Page
o= | | Plan-G3 (v 3.0.0.34) = L
File Hame Map Data View o @
New Plan Select Option Locations

El RecentPlaces  *  Nome

« Unspecified (4)

Facilities

B Desktop
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[ Decuments
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El ] Pictures 1
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B videos
& Homegroup
2 Josh UOSH-PC
A Peter Dodds

SceneryCache

Scenerylndexes

7] Scenery.CFG

™ Computer

Date modified

Type

File folder
File folder
File folder

CFG File

Sounds F52004: srowse.__|
- - Open ==
FS Connection X-Plane:
=
<[l » Computer » 0S(C:) » ProgramData » Microsoft » FSX » w [ 43| [ search s: o
print Additional S @\/ £ 5 | L
&PS Panel
Ao N = - 0 @

20KB

Figure 18 Browsing for the Location of Scenery.CFG

The scenery configuration file C:\ProgramData\Microsoft\FSX\scenery.cfg links Plan-G
to the default scenery and any third party airstrip scenery you have installed. Make
sure you have installed your scenery properly and make sure any airstrips you have
installed can be found within the Flight Simulator airports list. Be careful not to point
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Plan-G at the scenery.cfg file to be found in the FS directory itself. Thisis an FS
generated backup copy and is often not up to date.

B) Single Computer — X-Plane

There is only one X-Plane directory Plan-G needs to “know about”, which is the
location of X-Plane.exe. The default location is C:\X-Plane, but being user configurable,
it may be different from that.

Click in the X-Plane Location box, then enter or browse to the location of your X-
Plane.exe file. e.g. D:\X-Plane 10.

C) Networked Computers - FS9, FSX and X-Plane

The simplest, and preferred method of creating a database on a networked computer
is to create that database on a single computer, i.e. one with a Flight Simulator and
Plan-G both installed, and then simply copy the folder (My) Documents\Plan-G
Files\Data to the networked PC.

Note: This method does not enable Plan-G to be connected to Flight Simulator for
data transfer during flight. That is a separate function which requires the correct FS
Connection data to be set up (See section 8.7.5 below).

D) Networked Computers using a Network Drive

If you are reasonably computer-literate, another reliable way to get Plan-G to find a
networked computer is to map a Network Drive to the location of FSX.EXE. This has
the advantage that you can at any time, build the database on the Plan-G PC which is
going to use it, and Plan-G will use the Network Drive to connect to FS during a flight.

To “map” (create a short cut to) a network drive, do the following.
Windows XP

1. Open “My Computer”

2 Click the Tools menu, and then click Map Network Drive.

3. If you don’t see the Tools menu, press ALT.
4

In the Drive list, click a drive letter. You can choose any available letter. Starting
from Z: and working backwards is recommended for network drives; only to avoid
confusion with the “normal” hard disks, DVD drives etc., which start from C:

5. Inthe Folder box, type the network path of the folder or computer, or click
Browse to find the folder or computer.

6. To connect every time you log on to your computer, select the Reconnect at
logon tick box.

7.  Click Finish.

Windows Vista or Windows 7

1. Open “Computer”

2. Click Map Network Drive on the Command Bar.

3. Continue as for Windows XP.
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8.7.2

Your computer is now connected, or mapped, to the network drive.

So once you have successfully created a network drive; say Z:\ which points to the
network location //MyFSXPC\C:\Program Files\Microsoft Games\FSX, you only need to
enter Z:\ in the FSX Program: dialogue box.

In the example path above MyFSXPC is the “Network name” of the FSX PC, created
when your network was first set up. (Of course you must use the network name of
your FSX PC). You can repeat the process for another network drive Y:\ to point to the
location of FS9, if you have it installed. The location of Scenery.cfg, is usually the same
Networked drive as for the main FS program location.

You can of course simply enter the full path to these locations, but it is more prone to
typing errors than the network drive method, although Plan-G does remember them
between sessions and between program updates. Other FS applications can also often
make use of network drives.

The default paths in Windows XP and Windows Vista are different, so be careful to
map to the correct location. Unlike setting up Locations on a single PC, Plan-G cannot
automatically find FSX on a network, so it is important that you point Plan-G at the
correct locations on your FS PC.

Some PCs won’t reveal the target of the networked drive to Plan-G (and other
applications —it isn’t a Plan-G problem). The only solution of which TA Software is
aware is to go to (My) Computer, locate the network drive and open that drive in
Windows Explorer, i.e. just open the folder to view the contents, no more than that.
You can then close the window. Once that is done, Plan-G will be able to find your
networked drive by its drive letter. The problem has only been identified in Plan-G
when building a new database following a new release. Once this “trick” has been
done once, Plan-G always does seem to be able to find the necessary drive and its
database when you start it up afterwards.

Adding Additional Scenery Locations

The Additional Scenery Locations box enables the Microsoft FS9 or FSX user to include
scenery which has been removed from the scenery.cfg file, but the files themselves
are still in place on the system. Some scenery managers switch scenery entries in or
out according which region is being used, and therefore the scenery.cfg file may never
actually contain the entire scenery library at any one time. By specifying additional
locations in this box, which are to be added to the database, the user can have a
complete list of all their sceneries in Plan-G. In addition, this list can be used to
overcome problems caused by different network mappings when building the
database across a network.
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Figure 19 Adding Additional Scenery Locations

Click the ‘Add’ button to open a file browse dialog, and select the required scenery
folder —that is the folder which contains the “Scenery” (and usually but not always)
the “Texture” sub-folders. Click the Delete button — the one containing the red ‘X’ on
the left of the entry to delete that entry.

8.7.3 Units

Because different nationalities use different measuring systems, especially the
difference between the USA/Canada and Europe, in order to be as universal as
possible, Plan-G can display measurements in Stateside units (feet and inches/Hg); or
European units (Metres/Kilometres/Hectopascals).

Note: From 17" November 2011 the U.K. adopted the use of Hectopascals instead of
Millibars.

Units can be selected for Runway Dimensions, Speed and Distance, Altimeter Setting,
Time and Date, for English, American, or European preferences. The rest of the world
tends to adopt one of these three systems, although Plan-G allows you to select a non-
standard hybrid if you wish.

o= | o | Plan-G3 [v3.0.0.35)
Home Map Data Wiew

New Plan Seleet Option General Units
}. Open Locations Runway Dimensions

a @ Metres Feet

Save As f ]

| Units 5
Speed and bistance
Recent @ Nautical Miles / Knots Miles / MPH () Kilometres / KPH
Sounds

Export QMNH / Altimeter

Ficormection @ Millibars / Hpa ) Inches Hg

Print

GP5 Panel Mav Log Time Display
@ UTC ) Local
Help User Aircraft
Nav Log Date bisplay
Traffic ® oo/M ) MA/OD
B3 Exit Weather Latitude and Longitude Display Format

@ Db° MM' 55.5" () becimal

General

Figure 20 The Units Page
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8.7.4

8.7.5

The default system used is the English system, with local time and date used in the
printable Nav Log. Just click the relevant radio button to change a setting. Settings
are remembered by Plan-G, so it will probably be a once-only operation.

Sounds

You can choose to play alert sounds for three situations where your attention is
primarily on another task.

You can accept the Windows default (illustrated in Figure 21 below) or choose your
own, as long as Plan-G is told where to find the sound files.

4| Plan-G3 (v 3.0.0.35)
Hame Map bata View

New Plan Select Option Sounds
/. Open Locations [#] Play Sounds
= Units WNAV Profile Alerts
Rucent i C:\Windows\Media‘\notify.wav Browse. | |Te.ﬁ‘
Sounds
Extort T Waypoint Alerts
e €:\Windows\Media\notify.wav Browse...| [Test|
Erins PS5 Panel
Minimuns Alert
Help User Aircraft Browse...| |Test|
T
B9 Exit Weather
General

Figure 21 Sounds Page

The three alert sounds available are: -
1. VNAV Profile Alerts: The alert sounds:

e One minute before Top of Descent, and
e When you reach 500ft above your target altitude.

2. Waypoint Alerts: Waypoint alerts sound approximately 30 seconds before
reaching a waypoint.

3. Minimums Alert: This sound is played on final approach, 200ft above the airfield
elevation. Itis not set by default.

FS Connections

There are a number of important configuration options within this tab. They are

explained in detail for the various connection options in Section 14.3 “Connection to
Flight Simulator”.
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Plan-G3 (v 3.0.0.35)
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Figure 22 FS Connections Page

The following two tables are a simple summary of the most commonly used of those
options for FS9 and FSX.

FS9 & Plan-G on FS9 & Plan-G on
FS9
same PC network
Connect with FSUIPC FSUIPC
Network Mode Not used Not used
FSX Computer Not used Not used
Server Port/Pipe Not used Not used

FSX FSX & Plan-G Fsil(e%vscl)?z-vsi?hn a FSX & Plan-G on a
on same PC . network with FSUIPC
SimConnect
Connect with | SimConnect SimConnect FSUIPC
Network Not used IPva (V\./m' XP) Not used
Mode IPv6 (Vista/W7)
IP Address (192.168.0.2
FSX localhost etc) Value must be Not used
Computer same as
SimConnect.xml
Server Range 4500 to 4510
. Not used Value must be same as | Not used
Port/Pipe .
SimConnect.xml
X-Plane & Plan-G X-Plane & Plan-G on
X-Plane
on same PC network
Connect with XPUIPC XPUIPC

Note: Connection Protocols are fully described in Section 17.2. If installing FS9 & Plan-
G on a network, you need Peter Dowson’s WideFS, as well as FSUIPC. There are more
details about WideFS in section 19.2.1.

Page 26 of 128



Plan G User Manual V 3-1.061 October 2012

8.7.6

The PFD Panel

The PFD Panel option allows you to configure the Primary Flight Display window which
will display primary flight instrument indications whenever Plan-G is connected to an
active FS session (See Section 12.9 for details of using the PFD panel).

o | il Plan-G3 (v 3.0.0.35)
Home Map Data View
New Plan Select Option GPS Panel
Ji Open e Air Speed Indicator WNAWV
Target Altitude:
Oirs Max Airspeed Kifs. ‘ 1000 | ft. I Above Waypaint  « ‘
Recent
Sounds . Target Pasition:
Course Deviation ;
Export F5 Connection CbISensitivity: nm ‘ Before Waypoint v|
s [ Auto - i
X f e e ) VMNAV Profile:
el &PS Panel
Waypoint/ETE Display FHimin
Help User Aircraft Upper: | Distance fo Waypt |
e (R [0 )
B3 exit Weather
General

Figure 23 PFD Panel Configuration Page
Max Airspeed

Determines the displayed range (0 to <value>) of the Airspeed Indicator.

CDI Sensitivity

This is the course deviation that can be tolerated before Plan-G will update the CDI
bar. Choices are (deviation from flight plan track): -

e Auto

e 5nm

e 125nm
e 0.5nm

VNAYV Targets\VNAYV Profile

VNAV stands for Vertical Navigation, more familiar to those who fly high and need to
plan how to get down, than the VFR flyer cruising at 2000 feet. IFR pilots must
descend at a rate not less than 500 feet per minute, so the profile value is important
too. These parameters determine where and when Plan-G will issue its popup warning
windows to alert the pilot to his progress along the planned route.

Waypoint/ETE Display

These two selections determine the additional information Plan-G displays at the top
and bottom of the GPS panel. Choices are:

e Distance to Waypoint

e ETE (Estimated Time En Route) to Destination (how long will it take from here to
get to the final destination)

e Time to Waypoint
e Heading to Waypoint
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8.7.7

User Aircraft

This page sets up options about your own aircraft. Firstly you can choose whether to
display your own aircraft or not.

You have the ability to show your flight “trail” or “track made good” (what it is called
depends on who you talk to). You can change the colour and line width if the defaults
are not to your liking. You can also record and save your trail for future analysis.
Practice those overhead joins or procedural turns and then see what flight profile you
actually achieved against the neat version on the approach chart!

Note that flight trail display and recording is selected “On” by default when Plan-G is
first installed.

The three radio buttons; Free, Sync and Lock describe how the yellow user aircraft
behaves in relation to the map. These functions are also available and the option can
be changed from the Home ribbon. The tooltips describe exactly the behaviour in
each case.

P
o= | 1l Plan-G3 (v 3.0.0.35)
Home Map Data View
o]
New Plan Select Option User Aircraft Parameters
(when connected to FS)
. Open Locations . 4
= Aireraft Breadcrumb Trail
- Units 9| bisplay (F6) [¥] Show Trail
Recent Refresh Rate (seconds) lIl [#] Log Trail
Sounds —_—
Map Sync Colour: | Magenta a v‘
Export
FS Connection Free @ Sync () Lock width 3 _‘
Print ] Update TAS from FS
eionael L i Radio Stack
——————— ¥| Show Waypoint Alerts
Help User Aircraft VFR Code: @ 1200 ©) 7000
wEE
B exit Weather
General

Figure 24 User Aircraft Options

Free: The Map and user aircraft are not synchronized. You can move the map
wherever you like, and it won't be synchronised with the plane. If you don’t move the
map, the plane will fly off the edge (and will never be seen again.)

Sync: The Map will move as necessary to ensure the yellow aircraft remains visible on
screen. You can move the map, but it will re-centre on the yellow aircraft when it is
refreshed a few seconds later (10 seconds is the default, but it can be changed in the
FS Display window.) If you leave the map alone, it will stay where it is until the plane
reaches the edge, when it will re-centre.

Lock: The user aircraft icon stays in the centre of the Map which is re-centred on the
user aircraft at every refresh. The default refresh rate is 5 seconds, so this option can
degrade Plan-G’s performance on some less powerful computers.

If the “Update TAS from FS” tick box is ticked, and if a flight plan is loaded, and if Plan-
G is connected to FS, then Plan-G shows the true airspeed (TAS) in the Airspeed
dropdown (accessed from the Home Ribbon), taken directly from FS. The user will
have entered an estimated indicated airspeed in the Airspeed dropdown while
compiling a flight plan, but if the “Update TAS from FS” tick box is ticked, that value is
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replaced by the TAS from FS. Effectively the flight plan is updated dynamically during a
flight.

If the “Show waypoint alerts” tick box is ticked an alert is displayed before reaching
the next waypoint on your flight plan.

7000 is the International Civil Aviation Organisation (ICAO) standard code for VFR
where no other code has been assigned. This applies throughout Europe. In the UK it is
a general conspicuity code and does not necessarily imply VFR. In the US, Canada,
Australia and some other countries, the VFR code is 1200.

Select the appropriate radio button for the country you are flying in, or perhaps set it
for your home country and change it on the Radio Stack as required. Which ever is
selected becomes the default in the Radio Stack Transponder, and is the value sent to
your Flight Simulator when the “VFR” button is pressed on the Radio Stack
Transponder. The Radio Stack is a new feature in Plan-G version 3. See Section 12.11
for full details.

8.7.8 Traffic

This page sets up options about other aircraft when connected to FS. These may be
aircraft artificially generated by FS, (known generally simply as “Al”) or other aircraft
being flown on a multiplayer network such as VATSIM or IVAO, when you are logged in
to one of their servers.

Firstly you can choose whether to display Al/multiplayer aircraft or not. You can
decide the range beyond which they will not be displayed, and if the apron is full of
aircraft, you can turn off “Show Parked” aircraft, by unticking the relevant tick box.

In the same way as for your own aircraft, you can show the flight trail for each of
these. You can change the colour and line width if the defaults are not to your liking.
You can also record and save the trails for future analysis. See the chaos you caused
ploughing through Heathrow’s Class A airspace, VFR in your microlight, forcing all
those IFR go arounds and aborted takeoffs!!!!

| | Plan-G3 v 3.0.0.35)

| File Home. Map Dbata View
New Plan Select Option AL / Multiplayer Traffic Parameters
(when connected to FS)
A Open Locations > ks .
Aircraft Breaderumb Trail
Units [#] Show Moving [#] Shaw Parked ] Show Trail
Recent [E] Log Trail
Sounds
e Colour:
: F5 Connection 2
Refresh Rate (seconds) Width: |1 =
] PS5 Panel
Help User Aircraft
I freftie
Es] Exit Weather

Seneral

Figure 25 Traffic Options

Note: Al flight trail display and recording is selected “Off” by default when Plan-G is
first installed.
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8.7.9 Weather

The “Display Nearest Weather” tick box makes Plan-G get the weather from FSX. This
may be user generated within FS, or may be from an online system, e.g. if FSX is set for
Jeppesen, then that is the weather station data displayed. If connected to VATSIM or
IVAO, the weather fed to FS from VATSIM or IVAO via the pilot client software, is in
turn passed to Plan-G.

“Update Local” updates Plan-G with the wind setting from FS at the user’s location,
when connected to an online weather service.

o= | | Plan-G3 (v 3.0.0.35)
Home Map Data Wiew

New Plan Select Option Weather Parameters
A Open Locations [¥] pownload Weather from NWS
When Connected to FS
Units -
[ pisplay Nearest Weather [C] Update Local
Sounds

Export
’ FS Connection

&P'S Panel

Help User Aircraft

“ e

Exit | weather

General

Figure 26 Weather Parameters
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9.1

THE HOME RIBBON IN DETAIL

The "Home" ribbon menu contains the options you need to set up the parameters of
your new flight plan. Changes made here will be displayed in the "Plan" window, and
they will be saved to your new Flight Plan when you click the "Save" or “Export "
buttons.

Those ribbon buttons with a small down arrow beneath the label are "split buttons".
Clicking the icon itself will activate the default action (e.g. Find Airport), while clicking
the bottom half which has the label and the arrow will display a menu of choices (Find
VOR etc.).

= ! I= Plan-G3 [v3.0.0.34) E@l_].ﬂh
Hore. Map bata View o @
4 TOA~-T"pgpARCE = &S 7 @
\ H ® s &M |8 syne |
Find  Start  Alfifude Airspeed Winds Aircraft Quick Reverse Frame Copy Bookmark  KML Cannect Disconnect VATSIM
- Position profile Route | | OneRing - - " Free
Find Flight Plan Range Rings Bookmarks Flight Simulator

Figure 27 The Home Ribbon

Find

The "Find" button allows you to search for an airport or radio navigation aid. The Find
button is a “Split” button. Clicking the icon, (top half of button) activates the default
action, in this case Find Airport. Clicking on the lower half of the button drops down a
list of objects you can search for.

If the searched-for item exists in your simulator’s database, it will be found, and the
map will centre on it. If the item does not exist, Plan-G does nothing. You can select
“Cancel” to return to the map view, or enter some search text that Plan-G can find.
Search text is NOT case sensitive.

The filters at the bottom of the selection screen are used to narrow your search, if you
do not know the precise location you are looking for. If you know an airport’s ICAO
code, it is best to enter this in the appropriate box, as this is of course a unique
identifier.

e Find Airport (Search by ICAO code, by airport name, or by city name)
e Find NDB (Search by 3-letter identifier or by name or partial name)
e Find VOR (Search by 3-letter identifier or by name or partial name)

e Find User Waypoint (User Waypoints are other points of interest that can be
created by the user and added to a Plan-G database.)

e Address is the option you select to plan a flight over your home (in MSFS anyway)!
Enter the address and Plan-G will move the map centre to that address. It may be
used to find any address in the world, although it is only as precise as the data the
mapmakers can provide, so entering 137, Lansdowne Road, South Perth displays
just the city of Perth and its surroundings, although it is clever enough to find the
Perth in Western Australia rather than Perth in Scotland.

This feature is limited in X-Plane because the X-Plane database does not contain
“City” or “State” fields.
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9.2

9.3

The Find Airports dialog includes a “CSV” button. This button allows the user to save a
list of the airports in the table above it. This may be the whole FS database of airports
(may be a very large file) or just a small number, depending on the search criteria and
the Country, State and City filters applied. Clicking this button opens a “Save As”
dialog for the user to select a filename for the CSV formatted data and a location to
store it. By default these .csv files are stored in Documents\Plan-G Files, and can be
opened in Notepad, or a Spreadsheet program such as Excel.

—

.
t- Find Airport / |
Search
ICAQ Code Mame City
Perth
tICAO Nama ity te ountry
DMYT | Murphys Lndg Strip Perth New Yark United States -
ONY8 | Wenskoski Field Perth New York United States
ONY7  |Hart Perth New York United States =
EGPT |Scone Perth United Kingdom
NYED | Tohnson Perth New Yark United States —
YPIT | Jandakot Perth Western Austral| Australia
o« I ] »
| Filter
Country State City ;
Clear | |(WBY| | CSV
[ ) | | 1) ‘ =
[ Add to Plan | [ Cancel | i OK ]

Figure 28 Using the Find Function to Locate an Airport

Start Position

Plan-G extracts the runways and parking spaces available at your planned departure
airport from the FSX or FS9 database. Initially, the icon is a faded blue, but once you

have created your flight plan, it is displayed in black. This indicates that it is available
for use.

« Set Airport Start Pasition [ =]

T

RAMP GA Small

" PARKING 2 RAMP GA Small

PARKING 3 RAMP GA Small

PARKING 4 RAMP GA Small

&Y RAMP GA Small
PARKING 6 RAMP GA Small '

e ]

Figure 29 Start Position Window

Click on the icon to display a window containing the options. Some airports have more
options available than others, usually depending on how big the airport is in terms of
runways, taxiways, importance even. When the Flight Plan is saved, then loaded into

FSX or FS9, this will be the place (and zeroed elapsed time) from which your simulated
flight will depart.

Altitude

Here you can set the overall planned altitude for your new flight plan, after consulting
the Plan-G map for airspace and terrain constraints.
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9.4

9.5

9.6

9.7

9.8

"Passing Altitudes" can be set for individual waypoints, by editing the plan table
directly, although these altitudes cannot be used directly by FS.

I-<|! Cruising Altitude &J‘ r(} Set Airspeed &J‘
11500 ft 109 Kts
| Cancel | I oK I | Cancel ‘ I 0K ‘
Figure 30 Cruising Figure 31 Cruising Airspeed
Altitude Window Window
Airspeed

Your planned airspeed is entered here so that Plan-G can calculate the duration of
each leg and the complete flight. Plan-G uses true airspeed not indicated airspeed. If
you then change for a faster aircraft in FSX/FS9 after creating your plan, you will have
to manually change your estimated true airspeed here. With a flight plan open,
changing true airspeed recalculates the leg times and the flight total elapsed time

Winds

A wind value entered in this window will be used to calculate the heading required to
maintain your planned track. If a wind value is entered, Plan-G will also calculate and
display your ground speed.

If you are connected to FS9/FSX, and provided you have “Update local” ticked in
File/Options/Weather, then the FS9/FSX wind will be automatically passed to Plan-G
for use in flight plan calculations, as well as being displayed in the top left corner of the
map, and in the Winds dialogue box when you open it.

VFR/IFR

A flight is conducted either under Visual Flight Rules or Instrument Flight Rules. These
buttons select the flight rules and the plan will estimate a suitable altitude, taking
flight rules into account.

Quick

Clicking the “bow and arrow” icon (officially called the “direct to” icon by GPS
manufacturers) reveals a neat feature for a quick and dirty “A to B” plan. Enter the
ICAO codes for departure and destination, and Plan-G quickly generates a Great Circle
direct track between the two. This is very handy for short flights or answering
guestions such as “Have | got time to fly from A to B this evening?”

Reverse

This button reverses the sequence of waypoints in a loaded flight plan. This is useful
for creating a new flight plan for the return trip. The window title in Plan-G will reflect
a new name for the reversed flight plan, and when you save it, Plan-G automatically
changes the name for the new, reversed plan.
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9.9

9.10

9.11

9.12

9.13

The Frame Button

If a flight Plan is loaded and displayed on the map, clicking this button will move the
map view to centre the displayed flight plan into the middle of the map area, and will
adjust the zoom level to include the whole of the plan in one view. If no flight plan is
loaded, clicking the Frame button has no effect.

Copy Route

This option copies the flight plan route to the windows clipboard from where it can be
pasted into VATSIM or IVAO Flight Plans, or used for generating Pilot Reports (PIREPS)
for your Virtual Airline. If you want to exclude the departure and destination points
(for flight plans), press SHIFT as you click the button. The button is greyed out if no
Flight Plan is loaded. The copied data is simple text, e.g. (From Perth International to
Jandakot via two local NDBs) “YPPH CVM PRL YPJT”

Range Rings

Range Rings can be useful for estimating distance or time to run, if you are connected
to FS9/FSX. There are two modes: distance mode and time mode. The rings display in
yellow, centred on the current cursor position. The default distance range is 20 miles,
the default time range is 30 minutes. For VFR flying, you may prefer these values to be
10 miles and 10 minutes respectively. You can display 1, 2 or 3 rings, selectable from
the ribbon menu. Range rings do not require you to be connected to FS. They are
purely a mapping display function. You can only display one set of rings.

Switching Range Rings on or off is achieved from the right-click dropdown menu. See
section 13.1.2 for further details.

Bookmark

This is a most useful feature if you are in the habit of flying to and from places
scattered round the globe. Click the Bookmark button to open a files window. If you
enter a file name (of your choice) the current map view is saved with that name as a
bookmark. When you are elsewhere in the world, and want to quickly return to the
bookmarked map view, just click the small dropdown arrow below the Bookmark
button on the ribbon, and select “Open” from the two available choices. The
bookmark files window again opens, but this time, click on the bookmarked file name
of the location you wish to go to, and click the “Open” button at the bottom right of
the files window. The window immediately closes and the map view changes quickly
to the selected location.

KML

KML is a file format used to display geographic data in an Earth browser such as
Google Earth, Google Maps, and Google Maps for Mobile. Just as web browsers
display HTML files, Earth browsers such as Google Earth (and of course Plan-G) will
display KML files. KML and KMZ files are stored locally on the User’s PC and can be
copied, emailed or shared with other users as required.
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You can create KML files with the Google Earth user interface, or you can use an XML
or simple text editor to enter "raw" KML from scratch. KML files and their related
images (if any) can be compressed using the ZIP format into KMZ archives. KML code
is based on the XML standard and adds features that can be created with the Google
Earth user interface. These features include placemarks, descriptions, ground
overlays, paths, and polygons. When a text file is saved with a .km/ or .kmz extension,
Earth browsers know how to display it.

In Plan-G, .km/ or .kmz files can be opened and the features coded therein will be
displayed as an overlay on the Plan-G map. KML or KMZ files used can be located on
your PC. You only need to tell Plan-G where to find them.

When the user clicks the KML button, the Documents\Plan-G Files folder window
opens by default. So it is a good idea to store your KML and KMZ files there, perhaps
in their own sub-folder such as is shown in Figure 32 below.

#= Open
@Uv| v User + Documents » Plan-G Files » - ‘ érl | Search
Organize » New folder
4 Downloads 2 Name Date modified Type Size
Dropbox = g
5 . Charts 11-05-1213:33 File folder
= Recent Places - -
Data 21-04-12 00:19 File folder
DEM 06-05-12 14:30 File folder
Deskiop e : :
Y |5 . KMZ_Files 11-05-1213:33 File folder
- Libraries e .
= Old Flight Plans 06-05-12 15:09 File folder
<] Documents
_F . Profiles 11-05-1213:33 File folder
@' Music I
Trail 07-05-12 20:39 File folder
|| Pictures -
& vatsim 28-04-12 21:52 File folder
|l Pilot Pete - )
= WX 11-05-1213:33 File folder
B8 videos
& Homegroup
A Peter Dodds
1% Computer e s 5
File name: ~ [Google KMLfiles ("l “kmz) =|
[ Open ‘v] [ Cancel 1

Figure 32 A User-Created KMZ _Files Folder in Plan-G Files

3 Documents
,—J? Music
[/ Pictures
)| Pilot Pete
B Videos
& Homegroup
B Peter Dodds

8 Computer
I

File name:

r
- Open ==
@Qvl » User » Documents » Plan-GFiles » KMZ Files - |+,H Sec ,0I

Organize = New folder - 0 @
& Downloads “+ Name 2 Date modified Type Size
. Dropbox -
__| FTX_CRM_NA_GOLD_1.0 (1).kmz 11-05-1213:29 KMZ File 53 KB
=) Recent Places 2 / y
. || FTX_CRM_NA_GOLD_1.0.kmz 11-05-1213; KMZ File 53 KB
|| FTX_NZSLkmz 11-05-1213:30 KMZ File 18 KB
Bl Desktop = R ) i )
s = || FTX_PNW_NA_BLUE_14.2.kmz 11-05-1213:28 KMZ File 55 KB
o (] Morth American_0Zx NAL0_ORBXkmz 1105121331 KMZ File 32KB

v [GoogleKMLf\Ies(*.kml*.kmz)

M |

[ Open Cancel ]

Figure 33 Locally stored KMZ Files in a User-created Folder

Page 35 of 128



Plan G User Manual V 3-1.061 October 2012

9.14

9.15

9.16

Select the file you want to display and click ‘Open’ in the file window, Plan-G will
display the KML overlay. The KML window also opens if you click the small dropdown
arrow below the KML button on the ribbon, and select “Show” from the two available
choices.

If you select “Clear”, the overlay is removed from the map.

Note: Opening a KML overlay does not remove any existing overlays. You can have
more than one displayed at a time. The Clear command however, will clear all KML
overlays from the display. Be aware that loading and display of KML files may be quite
slow on some systems, which could make it seem as if Plan-G has stopped working.

Connect/Disconnect

This very important option requires initial configuration and is described fully in
section 14.3 below.

Map Panning Control

If the user is connected to Flight Simulator, the Plan-G map display update can be
controlled in one of three ways: -

e Lock: The User Aircraft remains in the centre of the map area, and the map moves
as the aircraft progress through the flight. This is very processor intensive and may
slow the computer down. The map refreshes every 5 seconds by default.

e Sync: When the User Aircraft reaches the edge of the map area, the map refreshes
with the aircraft now in the centre of the map area.

e Free: The aircraft moves independently of the map display, and may “fly off” the
edge of the displayed map. Dragging the map will bring the aircraft back into view.

VATSIM

Selecting this option will display all VATSIM controller positions which are active, the
boundaries of the airspace they cover (Tower, Approach, Centre etc., and small blue
aircraft symbols for all connected pilots. Hovering the mouse over a connected
position or aircraft symbol displays a tootip showing details of the connected position
or flight. It functions, therefore, in a similar way to the map view of Servinfo and
Vatspy.

Page 36 of 128



Plan G User Manual V 3-1.061 October 2012

10

10.1

THE MAP RIBBON IN DETAIL

The map Ribbon allows the user to configure the level of detail shown on the map.

User Configured Settings

At every zoom level, the default structure is designed to maintain the speed of map
refreshing by turning off more and more detail as you zoom out. However, the
settings for each item can be user configured for each zoom level to be displayed or
hidden according to preference.

(= Plan-G3 v 3.0.035) SR X
Home #hap befa View - @
Mlorge [ [ vors [ 1SEC . [Z1TCAC Airspace ] ROPM Airspace CI' €73 Airstrip | @ bisused | [ por | slider | g
[ Medium [ FloatPlane Bases [ NDBs  []] TSEC (unnamed) ¥ [ Centre [ Special Use | Helipad || @ Location | @ vep |0 usert | Y o
: ns/oc | Fiter Fifter Airspace | - ! " | Fifter Reset
] small Airports+ [l Lower Airways | ngygids~ Colour Guide ) Water | | A Obstacke | A 1FR [ User2 | waypoints~ | befoutts
Airports Navaids Airspace User Waypaints Layers

Figure 34 The Map Ribbon

User configured settings for each zoom level are set using the Marker pop-up boxes.
There is a marker pop-up for each of the groups; Airports, Navaids, Airspace and User
Waypoints, which is opened by clicking the small diagonal arrow-shaped ‘launcher
button’ at the bottom right of each section. Change the values as required and close
the Pop-up.

(3= "W Gi= Plan-G3 v3.0.0.38] o =3 o=
P ome Map bata View > @
Elarge [ Helipads [Z] TCAO Airspace [T RDPM Airspace C)] €73 airstrip |2 bisused | [ por | elider |
[ Medium [ FloatPlane Bases EC (unnamed) | [] Centre [ Special Use /<) Helipad | @ Location | © vep | Usert |
| S/10C Airspace = ) T 1
[ Small  [7] Farm Strips wer Airways Colour Guide & Water | | A Obstacle | & 17 | user2 |
Airports Navaids Airspace User Waypoints
Airport Marker Options E]
Display  Minimum Zoom
Large Airports il [7]
Medium Airports Ei [e]
/ Small Airports Eil a
Hunstanton Em@ ) I |
T Helipads E [o]
& Hot” | Float Plane Bases [o]
Farm Strips [ | 10 |
EG2F FETP R A
Fakenharm A
@
= @ Aylsham
- \ Stalham
e Hickling
K 'S y,
% 5 Bee.
b S &
%) EczH A
& & BG2T
Dereham N~ IR o rLem A
/ \ EGEH
El MAM SMM"H C
s 1 - 1 Acle =

Figure 35 The Airports Marker Options Pop-up

So, in the example above,

e Large airports will be visible at zoom level 7 or higher,

e Medium airports will be visible at zoom level 8 or higher, and
e Small airports will be visible at zoom level 9 or higher.

¢ Helipads and Float Plane Bases will not be displayed, and

e Farm Strips will be displayed at zoom level 10 or higher.
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10.2

The Airports ‘launcher button’ is ringed red in Figure 35 above, which is shown at
zoom level 10.

User configured settings for each zoom level are remembered for the next time you
open Plan-G, and unless or until you change them. So every time you return to zoom
level 8 the large and medium airports will be visible, but the small airports will not.
This same principle applies to each of the four map ribbon sections.

Airports

The Airports in Plan G are extracted from Flight Simulator and stored in the relevant
database. Airports close in the real world, and new ones are built. Flight Simulator is
however frozen in time (FSX is frozen at 2005, FS9 at 2004) so there will be differences
from the real world in Plan-G as there are in FS. For X-Plane, you can obtain airport
data updates from http://data.x-plane.com/, roughly in line with the Aeronautical
Information Regulation And Control (AIRAC) cycle of updates.

At each zoom level, airports are selectively displayed as described in Section 10.1
above. The as-installed default display levels for airporst are: -

e No Airports are displayed at zoom levels 1-6

e Large Airports are first displayed at zoom level 7

e Medium Airports are first displayed at zoom level 8

o Small Airports are first displayed at zoom level 9

The airport size reference used in Plan-G refers to the length of the longest runway.

e large: Longest runway is 3,000m or more in length;
e Medium: Between 800m and 2,999m in length
e Small: Less than 800m in length

You can also select which airports you wish to see by clicking the appropriate tickboxes
at the left hand side of the Map Ribbon. However, options selected by this method
are fixed across all zoom levels.

In this section of the Map Ribbon there is also a slender green arrow symbol labelled
ILS/LOC. This symbol, called “ILS feathers” is used on aeronautical charts to denote an
Instrument Landing System (ILS). If this button is pressed, those airports that are
selected for display (Large, Medium and/or Small), where those airports have runways
equipped with ILS/LOC in FS, will have “feathers” displayed against them on the
appropriate approach bearing.

Note that if a real world airport runway has an ILS which is not featured in FS9/FSX,
then the feathers are not displayed. (remember: FSX is frozen at 2005, FS9 at 2004),
so because real world approach aids are changing year on year, such differences may
become more common over time.
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10.3 Navaids

The radio navigation aids (Navaids) in Plan G are also extracted from Flight Simulator
and stored in the database and subject, naturally, to the same obsolescence as
Airports.

The Navaids Marker Options pop-up is opened by clicking the small arrow-shaped
launcher button at the bottom right of the Navaids section. The Navaids Marker
Options allows the user to select which navaids are visible at each zoom level.

= —— po— PR

Navaid Marker Options =)
Display  Minimum Zoom

VORs il [ 8 |

NDBs ] | 8 |

ISEC [ [9]

TSEC (unnamed) E [10 |

Lower Airways &l | & |

Figure 36 Navaid Marker Options

The tick boxes on the Ribbon also allow you to display or hide navaids. However,
options selected by this method are fixed across all zoom levels.

Very High Frequency Omni-Range beacons (VORs) and Non-Directional Beacons
(NDBs) are probably familiar to most Sim-pilots. There is an excellent tutorial on the
theory and practice of using these on the Cix VFR Club website at:

http://www.cixvfrclub.org.uk/training/tutorials/pdftutorials/The%20IMC%20Rating.pdf

ISEC is the standard aviation abbreviation for Intersections. Intersections exist in two
forms, named (normal) and unnamed. Named intersections are the standard type of
intersection. On the Navaids section of the Map Ribbon, the “ISEC” tick box switches
on or off named intersections, and the “ISEC (unnamed)” tick box switches on or off
unnamed intersections .

: s 74
Figure 37 The ORTAC Intersection In the English Channel

Named Intersections are now commonly used in VFR flight, resulting from the
increasing use of GPS worldwide. Some are included in GPS Databases and VFR pilots
can navigate to them simply. Because it isn’t easy to discriminate between those
useful to VFR pilots and those which are not, Plan-G includes all the ones identified in
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FS. (e.g. ORTAC at N50.00° W002.00° well known to VFR pilots crossing the English
Channel).

Unnamed intersections are computer generated 'infill' intersections. They still have
names, but these names are generally not memorable. Unnamed intersections are
generally not valid for use as a turning point on an IFR flight plan.

The intersection symbol is a small triangle. Blue triangles denote 'terminal’
intersections, i.e. they are "owned" by an airport, and typically form part of an
approach procedure. Magenta intersections are 'En Route' intersections, and typically
are associated with an airway.

In addition to the above, user intersections can be defined, and these are denoted by
green triangles.

Plan-G can display Lower Airway routes if the Lower Airways tick box is ticked. Airways
are radio and area navigation routes within which ATC ensures smooth and orderly
traffic. Lower Airways are routes up to a 24,500 feet ceiling above sea level, primarily
used for smaller aircraft or short flights. Upper airways are reserved for larger jets on
long flights, and are not provided in Plan-G.

By default, intersections and Lower Airways are not displayed at any zoom level.

10.4 FSX & FS9 Airspace

Airspace options are selected via the tickboxes in the Airspace Layer Options pop-up,
which is opened by clicking the small icon at the lower right corner of the Airspace
section of the Ribbon.

All airspace is classified according to a system defined by ICAO. The table below
provides an overview of the classes, and the specifications for each.

Plan-G displays Classes A to E if the “ICAO Airspace” tick box is ticked. Classes F & G
are commonly referred to as the “Open F.I.LR.” (Flight Information Region) and is
principally the domain of light aircraft, microlights, balloons etc. Most commercial
flights and all “heavy” category aircraft almost exclusively conduct their flights in
Controlled Airspace (CAS) under ATC control. When planning your flights it is essential
to know, therefore, where you can and cannot go, and Plan-G provides the

information.
Airspace Layer Options =]
Display  Minimum Zoom  Maximum Zoom
ICAO Airspace ] [ 7] [ 25 | H
N| centre | 4] | 7]
| RoPM Airspace ] | 8] |25]
Special Use [8] [25
Above 10,000 [ !
Below 10,000 ] g
e _

Figure 38 Airspace Layer Options

In addition, Plan-G can show controlled airspace either below 10,000ft for VFR traffic,
above 10,000ft for IFR traffic, or both.
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FR|SVFR|VFR ATC Separation Traffic Information
Clearance

Class| Controlled

A |Controlled [Yes |[Yes [No |Required |Provided for all flights  |N/A

Controlled ([Yes |[Yes ([Yes |Required |Provided for all flights |N/A

C |Controlled [Yes [Yes |Yes [Required g(/onFLded forall IFR & Provided for all VFR

D |Controlled |Yes |Yes [Yes |Required other IER/SVER VER

E [Controlled |Yes [Yes |Yes

for IFR other IFR/SVFR VFR where possible
Not Provided for IFR/SVFR to Provided where
F |Uncontrolled |Yes [No Yes . other IFR/SVFR where .
Required : possible
possible
G |Uncontrolled [Yes |No Yes Not . Not provided Prow_ded where
Required possible

Figure 39 ICAO Airspace Classification

In the real world, unpressurised aircraft are not permitted to maintain sustained flight
above 10,000 feet, (12,500ft in some countries), because the crew cannot take in
sufficient oxygen to maintain their mental faculties, and are prone to make irrational
decisions. Not good in an aeroplane! So if you are a light aircraft enthusiast, you can
switch off controlled airspace (CAS) boundaries above 10,000ft, and reduce Plan-G’'s
processing workload. And if you are crossing the USA in a 747 at 35,000ft, you can
save Plan-G some work by switching off the “Below 10,000ft” CAS tick box.

The “Centre” tick box displays or hides the Air Route Traffic Control Center (ARTCC)
boundaries. Generally referred to as “Centre” they are responsible for controlling
instrument flight rules aircraft en route in a Flight Information Region at high altitudes
between airport approaches and departures. In the UK the National Air Traffic Service
(NATS) combines the London Terminal Control Centre (LTCC) and London Area Control
Centre (LACC) at the Swanwick facility. Centre is unticked by default at all zoom levels.

RPDM Airspace is shorthand for “Restricted, Prohibited, Danger Areas and Military”
The latter are areas where the RAF does it’s much of its training; military low flying
areas, air to air refueling areas, high altitude danger areas etc.. For VFR pilots, these
are not normally an issue, and for IFR pilots, IFR routes invariably avoid these areas.
RPDM Airspace is either bordered in red or coloured red with a red border and is
switched off by default at all zoom levels.

In addition to the classified airspace, there is a “Special Use” tick box. “Special Use”
includes Areas of Intense Aerial Activity (AlAl) which are also RAF training areas but
where General Aviation traffic is not likely to cause too many problems. Special Use
airspace is coloured grey with a grey border and is switched off by default at all zoom
levels.

The Airspace Colour Guide icon at the right of the Airspace ribbon area opens a
window showing every classification of airspace and the boundary colours used in
Plan-G.
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10.5

10.6

As with the other marker pop-ups, you can also select the Airspace you wish to see by
clicking the appropriate tickboxes in the Airspace section of the Map Ribbon.
However, options selected by this method are fixed across all zoom levels.

X-Plane Airspace Data

There is no airspace data included in X-Plane. Plan-G can import Airspace data from
Flight Simulator to display on the map, assuming that X-Plane users have access to a
legitimate copy of Flight Simulator. Data transfer between MSFS and X-Plane is
described in detail in Section 11 below.

User Waypoints

User waypoints may be created in 12 different types

€3 Airstrip (9 Disused 17 POI [ Glider

(H Helipad ® Location © ver [0 Usert Y
Filter

L) Water A Obstacle & TFR [JUser2  waypoints~
User Waypoints

Figure 40 The 12 Predefined Types of User Waypoint

User Waypoints are stored in a User Waypoint database. Many of these are provided
in the Plan-G package in the file UserWaypoints.sdf. These can be optionally displayed
or hidden by ticking the relevant tick box on the Ribbon. All except IFR waypoints are
displayed by default, the icons showing with an orange background colour.

If you add your own waypoints (see Section 11.4) they can be categorised in one of the
12 options shown above. This also means that only selected ones are displayed, in the
same way as other features.

Note: Whenever a new version of Plan-G is issued, the file UserWaypoints.sdf is
overwritten, so if you create your own waypoints, be sure to keep a safe copy
somewhere outside the Plan-G folder. Further details are included in section 11.4.
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11  THE DATA RIBBON IN DETAIL

This is the ribbon which allows you to create the database for the simulator version
you have, and to select which database to use. You can create a database for FSX, FS9
or X-Plane, or for any two, or all of them. These database options are only available
for the simulator version or versions you have installed. If you do have more than one
simulator installed, either on the same computer or on separate networked
computers, then as well as creating a a database for each, you can create flight plans
for each one too in the relevant format.

Home Map bata View
| Ed =) N &
Display Display  Display X-Plane | Build Navigation Data Manage
FS5X Data | FS% Data 9/ Database Tools

Nav Database ] User Waypoints

Figure 41 The Data Ribbon

11.1 Building a Navigation Database

When you first install a new version of Plan-Gv3, this screen is presented first, with a
warning “First Data” tab above the ‘Build Navigation Database’ icon. You must build a
valid database before you can use Plan-G. See Section 5 above.

When you click on the ‘Build Navigation Database’ option, the following window is
displayed in which you can select which database to build, if that simulator is installed
on the same PC or a networked machine. (Networking is fully covered in a later
chapter).
. =
This action will build the internal database.

It may toke some time.

[7] Build FSX Database

B [ ouid F59/FS2004 Database

Build X-Plane Datobase

[ Settings...

Click UK or press Enter to start.

Cancel ‘

Figure 42 Database Build Options

Plan-G detects which simulator is installed on the PC and the options window reacts
accordingly, greying out any simulator option which is not available. In Figure 42
above, the FSX and FS9 options are shown black, but the X-Plane option is greyed out.
On the PC from which this screenshot was taken, both FSX and FS9 are installed, but X-
Plane is not.

If you click the ‘Settings’ button at the right of the options window, a new window
opens containing the current paths to the simulator Program, and Scenery.cfg (for FSX
or FS9). These are exactly the same options and serve the same purpose as the
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11.2

11.3

options accessed from the “File” menu, (see section 8.7.1 above) and give the user the
opportunity to change the paths if one or more is incorrect.

If you click the small diagonal arrow-shaped launcher button at the bottom right of the
‘Nav Database’ section of the Data Ribbon a same locations option window opens.

Selecting Which Database to Use

You can select which database is used for the map display (airports, navaids controlled
airspace etc.) by clicking one of the ‘Display...” icons at the left hand side of the Ribbon.
If the database for that simulator exists, the icon is shown with an orange background
and the map will display data from that database.

If no airports, controlled airspace or navaids, or any other aeronautical data appear on
the map when the correct “Active FS Version” for your sim is displayed, then you
should rebuild the database.

Note that for networked PCs, the icons will only display in the “Active” (black on
orange background) mode if the correct communication protocols are in place (see
section 17.2 below).

Data Tools

This option allows Plan-G data to be moved from one database to another. Itis
particularly useful for exporting Airspace data from FSX (or FS9) to X-Plane, which does
not contain Airspace data. In this way, a map showing X-Plane Airports, can be made
to show also Airspace boundaries.

- ~
#~ DataTools I&J
om ta f e to another

Airports table

Export Name List

l Merge Name List
Airspace Table
Export Data ‘ l Import Data ‘ ‘ Clear

[0].4 |

Figure 43 Database Tools

You can export the Flight Simulator Airports from FSX or FS9, for use in a different
application. The data file is saved in Comma Separated Value (CSV) format in your
Plan-G Files folder. The default filename is Airports_Export(PG).csv, and it contains the
airport Name, City, State and Country only. The data within Flight Simulator is not
affected.
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11.4

If you have an existing CSV file of airports, you can merge your exported data into that
file. When the Plan-G files window opens, select your existing CSV file. Duplicate
records are removed.

If you import a CSV file of Airport Data, the data is again merged, and duplicate
records are removed.

In a similar manner you can export Airspace data from FSX or FS9. As mentioned
above, this can be imported into Plan-G when an X-Plane database is active, to
populate the map with airspace data which doesn’t exist in X-Plane. The X-Plane files
are not changed.

The FSX airspace file contains over 21,000 records and the file size is approximately
8Mb. Be careful not to reimport the file into FSX otherwise the records are duplicated.

If you select “Clear” the Airspace data in Plan-G is cleared ready for importing fresh
data. If you are going to re-import the Airspace.csv file, then it is important that you
click ‘Clear’ first to avoid this duplication problem.

Managing the User Waypoint Database

To view the User Waypoint database and manage it directly, (adding, editing or
deleting waypoints), open the Data Ribbon at the top of Plan-G, and select the Manage
Database button. The “Manage User Waypoints” window will open.

r<j Manage User Waypoints l =5 &f
Category Name Identifier Latitude Longitude Elev. (ft) Variatiol
POT Aircraft Carrier Fleet Fleet -27.20212173 |153.6355591 |0 3488 |=
POL Yandi Mine 2 YANDI2 -22.73090744 | 119.1038132 1972 368.33 IS
Obstacle 2nd Severn Bridge (Toins EGTG201) |New Severn (5157086182 |-2.691502094 |0 34
Glider aaatest aaa 56.28629739 10.54361343 |82 358,92
POL Abbot Pt Coal Facility Abbott pt -19.87974548 |148.0806969 |0 361.82
Obstacle Aberthaw EGFF2014 51.3857193 -3.402817011 |0 3.65

| Airstrip Abilbah Abilbah -24.71198273 |144.2910919 | 928 351.89
Airstrip Adaminaby YADY -35.99745178 | 148.7958679 | 3888 34747
Airstrip Adelang Adelong -35.31274414 |148.0798645 | 1299 34797
A‘ Airstrip Agnes Waters YAWT -24.2018795 |151.8921661 |128 360,01
q Obstacle Aintree 1716902 53.45563889 |-2.957067013 |49 3.88
—u: VRP AINTREE RACECOURSE LIVERPOOL |53.472067151 |-2.939167023 |49 3.87
= Airstrip Airey's Inlet AIREY -38.46628952 |144.062088 |92 348,57
: f\‘ Obstacle Airth (Joins 150A010) 150A007 56.06742859 |-3.741899367 |3 479
e ’.""“_'- Airstrip Albany Park YAPK -13.08650112 |131.03063064 | 594 356.44
v '\ Obstacle Albury Park 2300387 51.20808029 |-0.475816697 | 400 2.5
| VRP ALDERBURY OLD SARUM 510423317 | -172B667 253 2.94 -

kil I »
Import... | | Export..

Figure 44 The Manage User Waypoints Window

11.4.1 Editing Records

If you double click in any “cell” in the database, its row is highlighted in blue. A second
click on the cell highlights it in white surrounded by a heavy black border. The text or
numerical value in that cell can then be changed. Clicking “OK” will save the changes.

ALDERLEY EDGE HILL MAMCHESTER | 53.29050064086091 (-2.20733308792114

BARTOMN AERODROME MAMCHESTER | 53.4693298339844 (-2.38750004768372
BUXTON MAMNCHESTER EERG cEpEiaplilzi -1.90766704082489
COMNGLETON MAMCHESTER | 53.1590003967285(-2.17516708374023
HILLTOP MAMCHESTER | 53.3383293151855(-2.17116689682007

Figure 45 Editing The User Waypoint Database
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11.4.2

11.4.3

Deleting Records

Left-clicking a record will select (highlight) it. If Shift is pressed while selecting records,
multiple contiguous records can be selected. If control (Ctrl) is pressed while selecting
records, multiple non-contiguous records can be selected.

If you right-click a record, a pop-up menu appears which has two options: ‘Centre on
Map’ and ‘Delete Waypoint’. Shift-right-click or Ctrl-right-click will select contiguous
or non-contiguous records as in the paragraph above, but in this case, the pop-up
menu is also displayed rather than the highlight alone. When multiple records are
selected, only one option ‘Delete waypoint’ is offered.

Thus either a single record or multiple records can be deleted with one key press. The
deletion is not reversible, therefore a warning is displayed “This action will delete
row(s) from the database. Do you wish to proceed?” as a protection against accidental
deletion.

Importing Records

You can import or export data files containing user waypoints so long as the number of
fields matches exactly the number of fields in the User Waypoint database (9). These
files must be comma separated value (CSV) files of the form

[CATEGORY],[NAME],[IDENTIFIER],[LATITUDE],[LONGITUDE],[ELEVATION],
[MAGVAR],[TAG],[NOTES]

e.g.
VRP,BOLAM LAKE,NEWCASTLE,55.1254997253418,-.87133300304413,0,4,UK,

Note the order of fields that you must create isn’t exactly as displayed in the Plan-G
User Waypoint Database. Also note that the final comma denotes that the 9" field
[NOTES] is empty in the example above, but must be accounted for by that final
comma after “UK”. In other words, in any record you wish to import, you must have 8
commas otherwise the import will fail.
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#} Manage User Waypoints (== % 4)
Category MName Tdentifier Latitude Longitude Elev. (ft) Variatior = Ul
POI | Aircraft Carrier Fleet Fleet -27.20212173 |153.6355591 |0 [3482 [= .
I I I - I I
P ———— -
L +}= Open g
al g :
E Uv | .. ¢ PeterDodds » Documents » Plan-GFiles » - | +3 | | Search Plan-G Files P |
P
= E Organize Mew folder = S| @
B -
B | 4 & Downloads i Name Date modified Type Size
E .. Dropbox | Ll
1 = . Charts 14-05-1212:33 File folder
- 1= Recent Places g
A | Data 14-05-1214:44 File folder
- Ei e .. DEM 06-05-1214:30 File folder
esktol -
N al =2 1 g 3 .. KMZ _Files 11-05-12 23:03 File folder
ibraries
E. “?j : | 1. My User Waypoints 14-05-12 22:14 File folder 1
=] Documents =
Al ‘J‘ e .. Old Flight Plans 06-05-1215:09 File folder
usic
a, = pi T J Profiles 14-05-1212:33 File folder
. (&=l Pictures
e | Al j A o Trail 14-05-1219:30 File folder
g 1| Pilot Pete
E I E Vi watsim 28-D4-12 21:52 File folder
ideos
Vi & H 1 WX 14-05-12 22:06 File folder
omegrou =
Bp ; ddp Airports_Export{PG).csv 14-05-1213:55 Microsoft Excel C... 11285
eter Dodds gy |
Airspace_Export(PG) 21258.csv 14-05-12 16:03 Microsoft Excel C... 797 -
18 Computer e o -
Z ™ !
- File name: - [User Waypeint Import Files (*.c ']
J 5 / I Open I'i [ Cancel ]

Figure 46 An Optional Folder Holding User Waypoints

Clicking the ‘Import’ button opens a folder window for the user to select the (correctly
formatted) User waypoint CSV file. Double clicking the CSV file, or clicking once and
selecting ‘Open’ starts the import process. Duplicate records are not copied.

+~ Manage User Waypoints = ‘ == ':53 |
Category Name Identifier Latitude Longitude Elev. (ft) Variatior
POL Aircraft Carrier Fleet Fleet -27.20212173 |153.636565%81 (O 3488 B
POL Yandi Mine 2 YANDIZ -22.73090744|119.1038132 | 1972 368.33 Ej
Cbstacle 2nd Severn Bridge (Toins EGTG201) |Mew Severn | 5157086182 |-2.691502094 |0 34
Glider aoatest aoa 56.28620730 (1054361343 (82 368.92
POL Abbat P+ Coal Facility Abbott pt -19.879745448 |148.0805%69 |0 3b1.82
Obstacle Aberthaw EGFF2014 51.3857193 -3.402817011 |0 3.65 U
| Airstrin Ahilhah Abilbah -24.71198273 (144.2910919 |928 36189
Airstll Plan 63 55 S -35.00745178 | 1487968670 3888  |347.47
Airst Adelong -35.31274414 |148.0798645 |1299 347.97
= E! @ Imported 29 of 20 records. YAWT -24.2018795 |151.8921661 (128 350,01
o Obst - 1710902 53.45663889 (-2.957067013 |49 3.88
VRP LIVERPOOL 5347267151 |-2.939167023 |49 3.87
Alrsti AIREY -38.4062855¢2 | 144.0602088 |92 34857
Obstd. 150A007 5606742859 |-3.741899967 |3 4.79
Air‘s‘]"— VAPK -13.08650112 (1310366364 |E94 366.44
Obstacle Albury Park 2300387 51.2080802%9 |-0.475816697 (400 2.5
’ B VRP ALDERBURY OLD SARUM  |B10423317  |-L72B007 2b3 2.94 -
4| I ] 3
Importing User Waypoints: 29: 1847 6 wilmslowO1
- 3 A

Figure 47 User Defined Records Imported

11.4.4 Exporting Records

With the User Waypoint Window open, highlight the records you wish to export and
only those will be exported. Contiguous records can be selected by holding down the
Shift key as you click each record. Non-contiguous records can be selected by holding
down the Ctrl key as you click each record.
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#~ Manage User Waypoints - . :'g J
Identifien Latitude Longitude Elev. (ff) Variation Tﬂ.g’ Notes
5h3.16426849 -6.859073639 0 EI One of the most famous ra =
53.09428024 -7.916391922 0 EI Remarkable History - just
h3.01086044 -9.388847351 o EI Centre of Irish Music
54.14474106 -6.026000977 [0} EI Maode famous in song
5217393112 -10.31341553 [} EI Area of outstanding rl:rful'cr
552400856 -6.5611287689 o EI Hexagonal basalt blocks cor .
1 RG73A3RA —11 3040146 0 EI First Tronsatlantic telegraj’
o EI Over 700 species of flora ¢
0 EI Land on the most beautiful
o EI Landed upside down in a bog
o EI Seat of the Ancient Kings ¢
(0] EI Longest river in the British®
[+] EI Huge rich deposits worked
(0] EI 240 miles long
: OZ NaW
YTYH -28.69533601 153.5403011 187 348.42 | OZ NSW| Caution birds; skydivers
Toumbaal -29.64270782 153.31103562 a9 348.16 O NSW tv

= A

Figure 48 User Defined Records Exported

Once a number of records have been highlighted, clicking the ‘Export’ button opens
the Plan-G Files folder window. Enter a suitable file name and the records will be
saved to that file with a .csv extension. A pop-up window appears in Plan-G on
successful completion of the export. If no records are highlighted, clicking the ‘Export’
button does nothing.

Technical Note: When you export user waypoints, The [CATEGORY] field as shown in
Section 11.4.3 above is a number, since that’s how the data is stored internally. But an
ENGLISH language text string is acceptable when importing waypoints. The
[CATEGORY] field is localized in non-English languages.
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12

12.1

12.2

12.3

THE VIEW RIBBON IN DETAIL

Plan-G can be configured to show as much or as little detail as you wish. Different
features are switched on or off depending on the zoom level chosen, to avoid
excessive data processing delays and of course map clutter. As a general rule, the
default settings are optimum for most users, but invariably each will have their own
preferences. The View Ribbon allows the user to filter unwanted general display
features, with the ability to turn them on or off as they wish.

Plan Inf PFD  Radios Traffic VATSIM Zoom Zoom
evation Analysis ot In 12 enTop

Show / Hide Contrals Zoom window

i = Plan-G3 (v 3.0.0.36) oS |
Home Mao Data View -
B e P GER@ AN #
s =L\ [
[Z) Map Overlays 1102 % S W
Plan ormation Aerodrome Weather  Trail Kee
I

Figure 49 The View Ribbon

Map Graticule

The Map can be displayed with a grid if desired, by ticking the higher of the two
tickboxes at the top left of the ribbon. This tickbox toggles on or off the graticule. This
option is unticked by default.

Map Overlays

This option is ticked by default. All the overlay features can be switched off by
unticking the lower tickbox. If you want to just look at the map without any
aeronautical information displayed at all, click this tick box to remove the tick. Click
again to replace the tick and all the overlay data is redisplayed.

The ten control icons to the right of these tickboxes each opens a pop-up window
showing additional information to that provided on the map by default. The next
section of the ribbon controls the zoom level and the final section will lock or unlock
any selected control window so that it remains on top of all other windows (or not)
when Plan-G is minimised or overlaid with another application such as Flight
Simulator.

The Plan Window

The Flight Plan Window is open by default when Plan-G is first run after installation.
The table contains the conventional flight plan headings, although initially when it
opens, it is empty, with a brown bar line across two thirds of the way down. Below
this bar appears the summary of your planned flight, above it the details of each leg.

As you build a flight plan, each new entry is added to the window in sequence and the
summary information is updated.

A vertical scroll bar will appear on the right of the details section if necessary, as new
legs are added. To view the complete plan, either drag the brown bar line down, or
drag the lower border of the window down to reveal the whole plan. If the window is
reduced in width, a horizontal scroll bar allows all 14 data fields in the plan to be
shown.
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and the window was left expanded when Plan-G was last closed, the window opens

expanded with the flight plan details visible.

Flight Plan

(5]

Woaypeint | Description | Heading ®M | Time | Dist (nm) | Track *M | Track °T | &,

Figure 50 The Plan Window Before a Flight Plan is Created

Flight Plan: Cix Welshpool to Welshpool J »
Waypeint | Deseription | Heading °M | Time | Dizt (nm) | Track °M | Track °T | 6/S (ktz) | MEF | Passing Alt | ATA | XRef1| XRef2 | Notes
EGCW Welshpool 003° 0 o 0oo® 000° 100 a
Cix001 Builth Wells 201¢ 18 30.2 201° 197° 100| 2700
EGRO Wolverhampton 0&5° 28 47.3 065" 062" 100| 2200
EGCW Welshpool 285° 20 33.2 285" 282° 100| 2700
Start Pos: 4 Wind: 000° at O Kts.  Altitude: 2000f+. (Suggested Altitude 7000ft.)  Total Distance: 110.7 nm Total Time: 1:06
TAS: 100 Kts.

Figure 51 Plan Window Expanded to Reveal Flight Plan Details
MEF (the ninth and last column populated by Plan-G) stands for the Maximum

Elevation Figure, and is the highest point (not including masts, skyscrapers etc.,) in a

0.5° square through which the track passes. The MEF for a leg analyses all the grid

squares through which the leg passes, and uses the highest value. The source data is
the National Oceanic and Atmospheric Administration (NOAA) 1.2km GLOBE dataset —

the same source as the DEM tiles described in the next section.

When your plan is expanded, you can add or delete waypoints, move the waypoints up

or down the plan add snippets and an alternate destination by right clicking the
relevant entry in the plan to reveal the dropdown menu of options.

Flight Plan: Cix Welshpool to Welshpool "
| Waypeint | Deseription Heading °M | Time | Dist (nm) | Track ®°M | Track °T | 6/5 (kts) | MEF | Passing Alt | ATA | XRefl| XRef2 | Notes
EGCW Welshpool 003® Q 1] 0oo® ooo® 100 o]
Cix001 Builth Wells 201¢ 18 30.2 201° 1977 100 | 2700
EGBj e HNED . e 28 47.3 065" 062° 100 2200
EGC) 15 20 332 285° 282° 100 | 2700
= Show Airport Diagram
clem—
Star Move Waypoint Ug ts.  Altitude: 2000+, (Suggested Altitude 7000ft.)  Total Distance: 110.7 nm Total Time: 1:06
TAE: Move Waypoint Down
Insert Waypoint Above
I Insert Waypoint Below |
—_— Cross-References.,
Insert Quick Snippet...
Eron Insert Snippet file...
\h\\. Add Alternate
Delete Waypoint
L Set Author

—_—

Figure 52 Flight Plan Editing via the Dropdown Menu
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12.4

Plan Elevation Window

This feature requires the optional download and installation of one or more Digital
Elevation Model (DEM) tiles from the NGDC 'GLOBE' (Global Land One-km Base
Elevation) website at http://www.ngdc.noaa.gov/mgg/topo/gltiles.html. There are
sixteen files covering the whole world, each one downloadable from one of a row of
links labeled A to P below the diagram of the world. Do not click on the graphic as that
results in you being navigated away from the page.

The tile files are TAR compressed files with the extension “.gz” or “zip”. Both can be
extracted with Winzip or Winrar. The extracted files have no extension. You need to
download and install a minimum of one tile to enable the Plan Elevation Window
functionality in Plan-G, but you do not need to download and install every tile. No
elevation data will be shown in Plan-G where tiles are not installed. The extracted files
must be placed in your Documents\Plan-G Files\DEM folder.

For example, Documents\Plan-G Files\DEM\b10g is the file for the tile that covers the
western half of the USA and south-western Canada.

When the Plan Elevation icon is selected from the View Ribbon, an elevation window
will open at the top of the Plan-G screen.

If no tile files exist in the folder Plan-G\DEM the Plan Elevation tick box is displayed in
a faint grey and cannot be selected. If no flight plan is loaded the elevation window is
displayed, but contains no elevation data.

The Flight Plan Elevation window shows the total profile for the flight as a continuous
profile even if the flight Plan comprises multiple legs which are not in a generally
similar direction.

In the example below, a flight plan has been created across Canada from Port Hardy
British Columbia to Calgary, Alberta, crossing the Rocky Mountains. As you would
expect, the elevation profile is quite interesting.

Flan Devation

L3

VFR Port Hardy to Calgary Intd

Figure 53 Flight Plan Elevation Window overlaying the Map Window

In the example above, the DEM profile is shown green, the Flight Plan altitude is
shown as a solid blue line, (at an impractical 2000ft), and the highest point on track —
the Maximum Elevation Figure (MEF) is shown as a solid maroon line, at approximately
13,000ft. The distance is shown along the x-axis.
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12.5

If, for example, the flight crosses a range of mountains and includes a return track
reversing the outbound leg, such as the one shown below between Hawarden EGNR
and Caernarfon EGCK crossing Snowdonia in North Wales, the same mountain range
will be shown twice, the second being a mirror image of the first. It is important to
realise this when interpreting the diagram.

Plan Elevation
=)
VFR Hawarden to Hawarden ]
50 = 3
& | h — - 5 - P— - | ®Planned Altitude <
T - o MEF
0 10 20 30 40 50 60 70 80 %0
: 7 ™ Ground -
Distance (nm} I
|

Figure 54 A Mirrored profile for an “Out and Back” Flight Plan

The Information Window

By default on first loading a new version of Plan-G, this panel is shown expanded. It
provides important information (as its title implies) about the feature currently
beneath the mouse pointer. This may be aerodrome data, (active or disused),
controlled airspace data (name, type and boundary altitudes) or radio navigation aids
type and frequencies, or all of these, for example, at a major airport. The Latitude and
Longitude of the mouse cursor location is always displayed.

The context menus vary in content, but the Lock Info Panel is

always the last item.

Start flight plan at airport X7LF
Show Airport Diagram

Spot Elevation: 997 ft.

Show Radial

QDM: Range and Bearing
Display Range Rings

Hide Range Rings

Lock Info Panel

Show Airport Diagram
Spot Elevation: 243 ft.
QDM: Range and Bearing
Display Range Rings
Hide Range Rings

Lock Info Panel

Start flight plan at airport EGEW

Figure 55 Lock Info Panel in Dropdown menus

Add airport EGTC to Plan

Select Alternate Destination

Add VOR CFD to Plan

Show Airport Diagram

Instrument Approaches

Spot Elevation: 256 ft,

METAR: EGTC 1810507 06013 KT 9000 FEW025 15/10 Q1003

TAF EGTC 1308002 1809,/1815 04010KT 3000 FEW045
BECMG 1509/1812 9999 PROES0
TEMPO 1812/1515 8000 -5HRA

Show Radial

QDM: Range and Bearing

Display Range Rings

Hide Range Rings

Lock Info Panel

Information @

|| ATIS: EGCC 128.175 MHz

EGCC - Manchester

United Kingdom

Elev: 255 ft, MagVar: 2.9° W
Rwy: 0BL/23R 3045m x 45m As
Rwy: OBR/23L 3300m x 46m As|
ILS/DME O5R: IMC (108.2 MH;
IL5/DME O5L: IMM (102.5 MH
ILS/DME 23R: INN (109.5 MH
Approach: MANCHESTER RADA
Approach: MANCHESTER RADA
Approach: MANCHESTER DIREY
ATIS: EGCC 121.975 MHz

Clearance: MAMCHESTER DELT]
Ground: MANCHESTER 121.85 A
Ground: MANCHESTER 125.375
Tower: MANCHESTER 118,625 /
Tower: MANCHESTER 119,625 |/
MCT MANCHESTER 113.55 M

Elev: 278 f+. Variation: 4.

MCH MANCHESTER 428 KHz
Elev: 255 1. Variation: 4,

Class D SFC - 3500 MANCHESTY

(Class A 3500 + MANCHESTER T|

Figure 56 The

As the mouse pointer moves, the information displayed constantly changes, so you
can check out such information to help create a flight plan, e.g. avoiding certain
controlled airspace or finding out which runways at an airport have an ILS.
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The information displayed is colour coded: A white background is used for airport
data, a pale green for VORs, a darker green for NDBs and orange for controlled
airspace. Of course not all these items are included in every display.

The information displayed can also be locked so that the data for a particular area is
constantly displayed even though the mouse pointer is moved away. Right click on the
feature for which you wish to lock the information and the context sensitive dropdown
menu includes the option as the last item.

12.6 The Aerodrome Window
If you right-click an airport on the map and select “Show Airport Diagram” (second
option) from the dropdown, the Aerodrome Diagram is displayed.

Aerodrome: Luton (EGGW) = Aerodrome: Luton (EGGW) =]
EGGW - Luton - London

United Kingdom
Elev: 524 f+. MagVar: 2.0° W
Rwy: 08/26 2218m x 46m Asphalt
CAT III ILS/DME 26: ILT (109.15 MHz) 256°
CAT III ILS/DME 08: ILTN (109.16 MHz) 076°
Approach: LUTON 128.75 MHz
Approach: LUTON 129.55 MHz
ATIS: EGGW 120,575 MMz
Approach: LUTOM 126.725 MHz
Approach: LONDGON 118,775 Mkz:
Ground: LUTGN 12176 MHZ
Tower: LUTON 132,65 MHz
b o

08 o8

Figure 57 Airport Diagram Figure 58 Airport Diagram
Window Window with Overlay

If you click the small blue Information icon at the bottom left of the window, the
relevant information for that airport is displayed as an overlay on the Airport diagram.
No airspace or naviad information is included in this option — to see that detail you
have to use the Information Window (See Section 12.5 above).

12.7 The Weather Window
With Plan-G connected to FSX/FS9, and showing the user aircraft position, the
Weather drop-down data expander reads the weather data from FS9/FSX and shows
everything that FSX/FS9 “knows” about the weather conditions for the current flight.
This FSX/FS9 weather data may be the built in weather themes, user modified
weather, weather from an online server such as VATSIM or IVAO (if connected to such
a server), or real-world Jeppesen weather (FSX only). Plan-G displays all the available
weather data, as shown in the following extract.

If you select "Download Weather from NWS" (access via the File tab, in
Options/Weather), weather from the NOAA National Weather Service (NWS) will be
displayed without having to be connected to FS. The format displayed in the table is
very slightly different however, since it comes from real METARs, rather than the
adapted data provided by FS.
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Weather =)
MNearest Weather Station: E‘
| station | Timed At | Wind *T | visibility | Precip | Cloud | Temp °c | Dew °c | @NH | 1600

EGOS | 0316507 |060° 15Kts| 6000 |-RA |owvedwo| o | 7 | 1008 |
4 I I 3

Flight Plan Route Weather:

[ station | Timed 4t | Wind *T | visibility | Precip | Cloud | Temp *¢ | bew =c | qQNH [ 1600 #+ |
~ EGBT | 031650Z [180° 00Kts| 100KM | lar | 15 | 12 |03 | |
4| I | ¥

Figure 59 Weather Table

A yellow wind arrow is displayed in the top left-hand corner of the main Map window
whenever Plan-G is connected to Flight Simulator. It indicates the strength in knots
and the TRUE bearing of the wind, so you need to make the normal adjustment for
magnetic variation. (Variation west, magnetic best: variation east, magnetic least).

Trail Analysis

Trail plotting is enabled from the “File” tab, in Options /User Aircraft (See section 8.7.7
above). If Trail plotting is enabled, and Plan-G is connected to Flight Simulator, a trail
of the flight of the user’s aircraft is displayed on the map during the flight, and saved
as an International Gliding Convention (IGC) file. IGC files are an international
standard recording protocol designed for use in competitive gliding, but which can be
used to record any flight. The log records the callsign of the aircraft flown, the
flightpath, elevation and elapsed time.

If you wish to analyse a flight afterwards, and automatic logging is enabled, then you
can reload that flight and examine it. Select the ‘File’ tab, then ‘Open’, and select the
sub folder of Plan-G Files. Click the “Aircraft Breadcrumb Trail Files (.IGC)” from the
file type dropdown box at the lower right of the Trail Files Folder window. A list of your
saved logs is displayed from which you can select the one you wish to view.

4~ Open - 2
] [ 1 v PeterDodds » Documents # Plan-G Files b Trail ~ [ 42| [ Seorch Trait o E
2.8 , - [
Organize New folder = O ® /
- Connex
- F, & Name Date modified Type Size
[ Favorites
B Deskiop No ifeins inatch yois seaichl
& Downloads
Dropbox El y
= Recent Places r
Bl Desktop
- Libraries
%] Documents
o' Music
=] Pictures B
il Pilot Pete
B videos
v% Homegroup &
File name: + | Plan-G Flight plan files (*plg) =
Plan-G Flight plan files (*,plg)
FSX / FS9 Flight plan files (*.pln}
X-Plane FMS flight plan files (*.fms)
v3 Aircraft Breadcrumb Trail files (*JGC)
w2 Aircraft Breadcrumb Trail files (*.tet)

Figure 60 Loading a Logged Flight Trail
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When the trail loads (it takes a few seconds) it is displayed on the map, which is
moved to display the whole route, and the vertical profile is also displayed.

- nnect — 1 | VATSIM
I—|’ Free |

\.?(‘| Flight Simulator

et Disco

Trail Analysis

F3

Trail CXA470 2012-5-7 (CYPK-CYBW)

20:40 20:50 21:00 21:10 21:20 21:30 21:40 21:60 22:00 22:10 22:2022:30 22:40 22:5023:00 23:10 23:2023:30
10000

M Altitude
M Ground

Height (Ft)
3
2
[=]

=}

‘D

: 9 Cranbrook \
© N
: @ 7

Figure 61 A Trail Analysis Example

The example above shows a flight by an aircraft with the callsign CXA470 flying a route
from Pitt Meadows, British Columbia to Calgary, Alberta, in Canada. The pilot was
attempting to cross the Rockies below 8000 feet all the way, hence the very
convoluted trail towards the end. The vertical profile shows that he was forced to go
higher at times. The vertical profile window title is generated as part of the IGC
protocol and comprises the aircraft callsign, the date of the flight and departure and
arrival airports.

To close the vertical profile window, click the Trail Analysis icon on the View ribbon.
To close both the trail and the vertical profile, click the large red cross at the top left of
the Vertical Profile window.

Note that although a trail is generated during a flight when connected to FS, the
vertical profile is only created from the saved log file, so that, if selected, the vertical
profile window remains empty during a flight.

Primary Flight Display

Selecting the Primary Flight Display (PFD) icon displays your aircraft’s performance
instruments. This can be useful, for instance, where you have only one monitor, but
you need to check out progress on Plan-G and also make sure your hand flown VFR
aircraft doesn’t suddenly enter a spiral dive while your attention is elsewhere. If used
in conjunction with the Radio Stack Autopilot (See Section 12.11 below), it is possible
to conduct almost an entire flight from Plan-G and not look at the aircraft in Flight
Simulator at all, not that this is recommended.
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Figure 62 PFD Panel

PFD: C172 G-CIXN =

Figure 63 The PFD Panel “Alive” during a Flight with a Flight Plan Loaded

Figure 62 above shows the PFD Panel as it appears when no flight plan is loaded.
Figure 63 shows the PFD panel during a flight with a Flight Plan loaded.

The instruments are not labeled, but it is obvious which they are — the basic “6-pack”
except for the Horizontal Situation Indicator (HSI) which has additional features
described below. Airspeed and altitude are also shown digitally.

The Horizontal Situation Indicator
An unique feature of Plan-G is a Horizontal Situation Indicator with more than
attitude! It incorporates four navigational features.

a) A Direction Indicator (DI)

b) A Course Deviation Indicator (CDI), and

c) An Automatic Direction Finder (ADF)

d) A Descent Profile Indicator

These features are only available, however, if a flight plan is loaded and Plan-G is
connected to Flight Simulator.

12.10.1 Direction Indicator

Most virtual pilots should be familiar with a DI. This one is identical to that found in
your aircraft, except that it doesn’t precess with time. If precession is not a term you
are familiar with, look up “Direction Indicator Precession” on the internet and read all
about it. The DI compass rose shows the magnetic heading you are flying against the
red lubber line at the top.
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12.10.2 Course Deviation Indicator

The yellow needle and the central bar form a CDI with a slight difference. Itisn’t tuned
to a VOR, but is indicating your deviation from the flight plan track line displayed on
the map. The sensitivity varies with distance from destination. Full Scale Deflection
(FSD) for various distances is shown in the table below.

Distance from Waypoint Sensitivity
More than 35nm FSD = 5nm from track
Between 2nm and 35nm FSD = 1.2nm from track
Less than 2nm FSD = 0.25nm from track

This is the same as the sensitivity of an ILS localiser, so is very precise.

12.10.3 Automatic Direction Finder

This is an ADF with a difference. The small green arrow works exactly like an ADF
tuned to an NDB, but it points directly to your next waypoint. It is not influenced by
thunderstorms or mountains of iron ore, so is more reliable than a real world ADF (not
that magnetic mountains are simulated in FS!)

It does get more sensitive as you get nearer to the waypoint, and swings round in the
normal way an ADF needle does as you pass the waypoint. When Plan-G decides it is
time to look for the next waypoint, it will swing round automatically to point to the
new one. If you are directly on track, this will be the instant that the aircraft passes
over the waypoint. If you are off track a little, it will swing round to about 150° or 220°
(depending whether you are left or right of track), before changing to the next
waypoint, so don’t chase the needle as you near the point of changeover.

12.10.4 Descent Profile Indicator

The fourth feature is the descent profile indicator. Whether you create an altitude
profile or not, Plan-G will calculate a Top of Descent point along your route. As you
near the Top of Descent, the profile bar (a small green letterbox shaped rectangle)
appears on the HSI dial, and descends downwards.

This is similar to a glideslope indicator and shows the rate of descent you need to
achieve to maintain your VNAV profile. It works in the same sense as an ILS glideslope
indicator. If the bar is below the centre, you should increase your descent rate, and if
it above centre you should slow your descent rate.

Full scale deflection on the profile bar is 1 degree above or below the profile (the same
as a normal ILS). This mimics the standard handheld Garmin (e.g. 296, or 496) VNAV
functionality. If you wish to disable the profile bar, set the Profile to 0ft/minute,
accessed from the “File” Tab in Options/GPS Panel.

The HSI tooltip contains context information about your position on the profile.
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12.12

12.13

The Radio Stack

The inclusion of a radio stack in Plan-G might at first
seem incongruous. However if you can recall any
occasion when you have needed to adjust a radio
frequency; transponder or autopilot setting but either =
you are in the wrong window of Flight Simulator and you (D
need to make the change quickly in busy traffic, or the
aircraft designer has made changing frequencies tricky
because the numbers are too small to be resolved
clearly by your slightly antique graphics card, or the
clickable hotspots aren’t quite in the right place — then
you will have wished for a radio stack outside the
Simulator, with easy manipulation. The less financially
challenged can buy hardware units, but Plan-G provides

Radio Stack

NAVICOM

a similar, free, option. If you have Plan-G on a separate ED
monitor with the Radio Stack displayed, you almost have T AR
the luxury of the hardware option, and certainly have
the ease of use. YER

. . 0J1]2]3f4]5]s)
The panel does not function (no numbers visible and
nothing is clickable) unless Plan-G is connected to Flight Figure 64 The Plan-G
Simulator. Radio Stack

Changing the numbers in Plan-G changes the numbers in the aircraft radios and also
works with VATSIM or IVAO ATC when connected to those networks. In fact it works
in precisely the same way as any Flight Simulator radio stack, so it will not be further
described here except to explain the convention of changing numbers. Click above the
numbers to increase them; click below the numbers to decrease them.

The Traffic Window

The Traffic Window shows a table of all the Flight Simulator “artificial intelligence” (Al)
or online traffic within a defined distance of your aircraft. The maximum distance for
the display of Al traffic can be user-defined on the Options page under the ‘File’ tab.
The default setting is 100 kilometres, approximately 50 nautical miles.

Traffic =]
| A/C | Tail No. | Alt. (ft) | Hdg °M | &/Speed (Kts) | Frem | To | Dist (nm) | Track *M
AAL2352 ( 39999 343 1064 34 051
EX5128 796| 0b4 133 16.8 085

Figure 65 Traffic Window

VATSIM

Opens a window which lists all Air Traffic Controllers and Pilots currently connected to
VATSIM worldwide, in alphabetical order by call sign. A separate tab is used for pilots
and controllers. All available data is displayed if the window is expanded in width, or
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12.15

scrolled with the horizontal scroll bar. The vertical scroll bar allows the often very long
list to be fully explored.

VATSIM =]

Pilots (522) | Controllers (55) |
Callsign  Name Aircraft  From To Groundspeed  Alfitude ETA  Time Online  Transponder Route
|9HBEJ B737/E |EPKT Katowice LOWT Innsbruck 450 40070| 22:28z 00:52 2200 LUPUX Z1: =
AT310 Mames removed H/B1/F [KTCM Tacoma PAED Anchorage 563 30040| 22:40z 02:08 1510 OLYMC2 CE'
AALOS0 | To protect privacy H/B772 | KDFW Dallas-F+ Worth |EGLL London 503 36808| 01:39z 05:09 1324 DIRECT VI
AAL1206 B738 |KBOS Boston TIS5T San Juon 342 16062| 02:20z 00:24 2200 LOGANG B
AALIZY T/MDB3/F|KLAS Las Vegas KATL Atlanta 330 25576| 02:37z 05:30 7223 +COWBY4
AAL141 H/B763/E | KSFO San Francisco KDFW Dallas-Ft Worth 329 16744( 01:59z 00:47 2200 SFO8 SFG
AALIB14 H/B763/Q| EGLL London KBOS Boston 431 33960| 03:18z 02:01 7526 CPTUGL 5
AALI66S H/B763/Q) TTPP Part OF Spain KMTA Miami 468 35933| 23:11z 02:44 2200 ARMUR L3
AALIT2 T/B738/F | KORD Chicage KEWR Newark 177 2660| 22:13z 01:02 1550 KORD/27L
Aar1Tan : |.J L L onar ssanin Lunos s vm:‘m Pollon £ VAlontl 224 a7l 29,11~ na.za 1nE1 nTvan z:

T FERTT T — - - TR T e

Figure 66 VATSIM Pilots World-wide

VATSIM =
| pilots (522) | Controllers (55) |

Callsign Frequency | Mame Rating Time Online ATLS

ABQ 16_CTR| 127.8B0 |Brodley Tice €1 00:27 Bradley Tice at your service. ZAB ARTCC and the ZFW ARTCC presensts Cross e

the Desert. A great trip over the AZ NM.and TX deserts featuring KPHX and KDFW.

Come join us June 16 start ing 2300Z. Feedback appreciated at zabartcc.net/feedback

BAIRES_CTR| 124.900 |Santiogo Villacorta Franchini I1 03:02 Baires Radar

CMH_TWR 132700 |bob jeffers s2 00:59 Columbus Tower

Information ALPHA Winds calm Vis 10SM Sky FEW200 Alt 3009

Landing & departing runways 10L & 10R. Visual approaches in use.

DCA_1_TWR 119.100 | Chad Gurchinoff 53 00:51 Woashington Tower (DCA)

Welcome to ZDCARTCE s prized DCA Airport!

AIRMET= and SIGMETs are included in the ATLS, if this is an issue. let me know. KDCA_ATLS 3
L

—
4 I ] »

Figure 67 VATSIM Controllers Worldwide

Zoom Controls

There are two zoom controls on the View Ribbon. A single click on either changes the
zoom level by one. If the View Window isn’t active, there are a pair of zoom buttons
at the bottom of the map window at the left of the status bar. For those with a mouse
which includes a scroll wheel, the scroll wheel will also zoom the map window.

In addition there are three configurable preset zoom buttons. By default they are set
to 8 times, 10 times and 12 times zoom level. Clicking the small diagonal arrow-
shaped launcher button at the bottom right of the preset zoom buttons group opens a
“Set Zoom Presets” window, where you can change the default settings to your choice.

Keep Window on Top

Click the pushpin icon and Plan-G stays on top of all other windows. This can be handy
if you are running with two monitors, (you wouldn’t want to use this feature while
flying, with a single monitor), if you have other windows getting in the way on
occasion. It can be a bit unnerving if you have Plan-G in full screen mode, as it can at
first seem that your computer is not responding to mouse clicks on other running
applications in the task bar.

Page 59 of 128



Plan G User Manual V 3-1.061 October 2012

13

13.1

13.1.1

13.1.2

13.1.3

CONTEXT MENU OPTIONS

Context menus with appropriate options are available in Plan-G when you right-click
on various elements of the display.

Right-Click on the Map

If you right-click on any part of the map a dropdown menu is displayed containing
several commonly used functions. The options available from the dropdown vary in
accordance with the way in which Plan-G is being used. If the DEM Elevation files have
not been loaded, then the version on the left below is displayed. If the relevant DEM
elevation file does exist in the Plan-G Files\DEM folder, then the version on the right is
displayed, which includes a spot height value.

Create User Waypoint Create User Waypoint

QDM: Range and Bearing Spot Elevation: 56 ft.

Display Range Rings JDM: Range and Bearing
Hide Range Rings Display Range Rings

Hide Range Rings
Lock Info Panel

Lock Info Fanel

Figure 68 Right-Click Map Dropdown Menus

If you right click on an Airport. VOR or NDB etc., the dropdown menus are changed to
be appropriate for those features. If Plan-G is connected to FS or X-Plane, the right-
click menu has an additional option “Move FS Aircraft to here”.

Create User Waypoint

You can create custom waypoints anywhere you like on the map without restriction.
This is particularly useful for VFR flight where towns, lakes, hills and other features are
requires as points of navigational reference.

This subject is dealt with in detail in section 14.2.1 below.

Get Fly-to Heading, Distance and Time

If Plan-G is connected to FS, this option provides a useful quick check on things like
What is the flight time remaining to <the point clicked> from my aircraft, given my
airspeed and the current weather? Will | have enough fuel to get to <the point
clicked>? How far have | come? The option also appears in the dropdown menu
displayed when you click anywhere on the map during a flight. The information is
displayed in a small pop-up window in the centre of the map window. Clicking ‘OK’ in
the window closes it.

Move FS Aircraft to Here

This can actually be a faster way of relocation to a new airport than can be achieved
via the Flight Simulator menus. However, it is actually a slew manouevre (the ‘Y’ key in
FS, not implemented in X-Plane), with some of the quirks of that action such as blurred
scenery (trying to catch up!) and your aircraft sometimes being airborne when it was
previously parked.

Page 60 of 128



Plan G User Manual V 3-1.061 October 2012

13.1.4 Spot Elevation

If the user has downloaded the optional Digital Elevation Model (DEM) tiles from the
NGDC 'GLOBE' (Global Land One-km Base Elevation) website (see section 12.3 above),
then Plan-G will display the elevation above sea level of the point which has been
right-clicked, as the second item on the right-click dropdown menu.

13.1.5 Show Radial

If you right-click on a VOR or NDB rather than an undefined point on the map, a ‘Show
Radial’ option is included in the dropdown menu. When ‘Show Radial’ is selected. A
small sub-menu appears which allows you enter a radial and distance FROM that
navaid. On clicking ‘OK’ the radial line is displayed on the map as a thin purple line.
You can repeat this multiple times from the same or other navaids, allowing you to
plot the intersection data of a point you may wish to fly to. A single 'Clear All Radials'
option on the dropdown menu will remove all radial lines from the map. Radials are
entered and displayed are in degrees magnetic. A checkbox allows you to select the
radial as 'inbound' which shows the radial line TO the navaid from the point the
specified distance from it..

13.1.6 QDM Range and Bearing

In the early days of radio, when transmission was carried out entirely in morse code,
the “Q-Code” was a series of letter groups starting with Q, each of which had a specific
meaning. A few, including QNH, QFE and QDM are still used in aviation. QDM means
"What is the Range and Bearing TO a distant point FROM a fixed origin.

For completeness, you should know that the Bearing FROM a distant point to the
origin — usually your aircraft —is QDR. It is sometimes used by real world pilots.
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Figure 69 QDM Display

The example above shows the distance from Tokyo’s Shimofusa Aerodrome and
nearby Iruma Aerodrome. The QDM feature can also be usefully used to measure any
straight line distance in Plan-G, such as the distance between two aerodromes. Place
the cursor at the point on the map to which you want to know the bearing and
distance from your aircraft or feature, and right click to display the dropdown menu
(see Figure 72 below). Select ‘QDM: Range and Bearing’. A red line will be drawn from
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the right-click point to the mouse cursor, with the range and bearing values displayed
in the Information Panel at the top with a blue background to separate it from other
information which may be valid for the point you have selected.

Right-clicking any point again will show a check mark on the dropdown menu against
the QDM: Range and Bearing line, indicating that QDM Line drawing is ON. Clicking on
‘QDM: Range and Bearing’ again on the dropdown menu will remove the check mark
and switch OFF the QDM feature.

Create User Waypoint

v | QDM: Range and Bearing
Display Range Rings
Hide Range Rings

Lock Info Panel

Figure 70 Select the Ticked QDM Option to Switch it Off

If you wish to draw a new line, then you must close the QDM option, and right click
again from the new point.

Display and Hide Range Rings
Place the “hand” cursor at the point on the map where you want the range rings to be
centred, and right click. Select ‘Display Range Rings’ from the dropdown menu.

If you want to move them, simply move the cursor to the new location and select
“Display Range Rings” again.

To hide the range rings, right click anywhere on the map and select ‘Hide Range Rings’
from the dropdown menu. Range rings are hidden by default, so if you exit Plan-G,
they will not be displayed when you re-start the appllcatlon
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Figure 71 Displaying Range Rings

Range rings can be set to display in units of distance or time. If time is chosen, the
rings will automatically be distorted to take account of any wind entered in the Winds
dialogue box (see sections 9.5 and 14.1.2).

Range rings do not require you to be connected to FS. They are purely a mapping
display function. You can only display as many sets of rings of range rings as you wish.
The example above shows one selection of two rings at 10 and 20 nautical miles radius
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centred on Sydney Charles Kingsford-Smith Airport, with another ring at 10 nautical
miles radius centred on Hoxton Park Airport.

Lock Info Panel

The information displayed on the Information Panel as you move the mouse round the
map can be locked so that the data for a particular area is constantly displayed even
though the mouse pointer is moved away. To lock information, hover the mouse over
the area on the map which displays the information required, then right click and
select “Lock Info Panel” from the dropdown.

Create User Waypoint
Spot Elevation: 157 ft.
QDM: Range and Bearing
Display Range Rings
Hide Range Rings

Create User Waypoint
5pot Elevation: 157 ft.

QODN: Range and Bearing
Display Range Rings
Hide Range Rings

Unlock Info Panel

Lock Info Panel

Figure 72 Lock the
Info Panel

Figure 73 Unlock
the Info Panel

To return to changing data as the mouse is moved, right click and select “Unlock Info
Panel”.

Right Click on an Airport

Right clicking the mouse on an airport symbol opens a different dropdown menu from
the one which is displayed when you right click on the map.

174 " awaney
X o Orpington ;%
£ ¢ Croydon I

A\ Purley P
Add airport EGKE to Plan

Coulsdon
Select Alternate Destination
Set Frequency on COM1 Radio
Set Frequency on COM2 Radio ¥ II
Add VOR BIG to Plan

Set VOR frequency on NAV1 Radio

Set VOR frequency on NAV2 Radio

Show Airport Diagram

Charts

Instrument Approaches

Lt’/_.i of Get Fly-To Heading, Distance and Time

Move F5 Aircraft to Here

- y '
/ Spot Elevation: 505 ft,
METAR: EGKB 0719202 21017 G27KT 180240 9999 SCT025 14/10 Q0995

gl

Je |
Crawley [
Py

TAF EGKE 0716592 0718/0721 21018KT 9999 5CT020
TEMPO 0718/0721 21021 G31KT

Haywiirds i
ryeam Show Radial

QDM: Range and Bearing
Display Range Rings

B\»ijess
il i i F
] Hide Range Rings
|

Lack Info Panel

Figure 74 Right-click on an Airport
The dropdown menu shows some options specific to that airport, some to any airport,

and some which also appear on the map right-click menu. The options are described
below.
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13.2.2

13.2.3

13.2.4

Start Flight Plan at Airport

Right-click on the departure airport on your plan, “Start flight plan at airport <ICAO
code>" (Plan-G fills in the ICAO four-letter code for the selected airport) is self
explanatory. If you right-click an airport after your departure airport, this option
changes to “Add airport <ICAO Code> to plan”. Figure 74 above has been deliberately
chosen to display almost all of the possible dropdown menu options. If the
information is not available for an airport, then that option is not included in the
menu. If, asin the example, a VOR is located at the airport, then the option “Add
VOR....” will also be included in the menu options.

Select Alternate Destination

What if you arrive at your destination and you cannot land there? In the real world,
there can be many reasons for this, but in FS, especially when flying on line with
VATSIM or IVAO, etc., there may be an aircraft already on the runway which does not
move as you fly your final approach. You clearly have to land somewhere, and that is
what the “Alternate” box is for in the online flying pilot client flight plans (though it
does not feature in FS created flight plans).

If you select this option, an additional line, but in red, is drawn on the plan from your
destination to the airport you select as your alternate. Importantly, because you don’t
want to be doing this while going around because of that unmoving aircraft on the
runway, the plan displayed in the Plan Window includes the distance, heading and
time, etc. to your alternate from your destination. The line of data for the
destination to alternate leg is shown in red.

Note: The alternate heading and distance is always calculated from your destination,
because standard aeronautical practice worldwide assumes that you fly to your
destination before diverting to your alternate.

Set COM/NAYV Frequencies

The context menu will also include a submenu of the radio frequencies that have been
defined by FS for that selected airport. (e.g. Tower, Ground, Approach etc.) Selecting

the frequency will set the STANDBY radio display for COM1 in your aircraft radio. You
will need to press the ‘Toggle Active-Standby’ button to activate the frequency, either
within FS, or on the Plan-G radio stack. The Submenu is only displayed when Plan-G is
connected to FS.

You can select the frequency on COM2 in a similar manner.

The context menu which is displayed when right-clicking on a VOR or NDB gives the
option to load its frequency into the NAV1 or NAV2 radios in the same way as for the
COM radios.

Show Airport Diagram

If you select ‘Show Airport Diagram’ from the dropdown menu, the Aerodrome
Diagram is displayed as a pop-up window (see also Section 12.6 above). You can use
the mouse wheel to zoom in/out, and if you hover the mouse pointer over the parking
spots, runways & taxiways the relevant details are displayed.
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Charts

If you create a folder called Charts within the Documents\Plan-G Files Folder, you can
store pdf format charts & instrument diagrams (plates) there. Create a sub-folder for
each airport and put the relevant charts in that folder. Then, when you open the
context menu by right clicking an airport it will include any charts thus stored.
Selecting one of the charts from the submenu will display it in its own window.

Note: The subfolders must be named using only the ICAO code for the airfield, (e.g.
Charts\EGBJ, EIDW, KLGA, etc.) otherwise charts will not be displayed.

Instrument Approaches

If an airport has instrument approaches built into FS, then there is a menu option in
the airport right-click dropdown to display them. They are much simplified versions of
real world Instrument Approach Plates, but if you are unfamiliar with instrument
approaches, then you will want to know what the diagrams mean.

When you first click on the Instrument Approach option, there may be a pause while
Plan-G loads the information, then a small “Approaches” window is displayed showing
all the approach procedures available for that airport in FS. (There may be several
others available for real world flight.)

Approach: HKMO |§
VORDME 03 -
VORDME 21 E
ILs 21

NDB 21

6PS 03

GPS 21 4

I Clear

Figure 75 Instrument Approaches Pick-list for Mombasa Airport, Kenya

The window is split in two by a black divider bearing the word “Transitions”. If you
click on one of the displayed approach procedures, two things happen: -

e Ablueline and a red line appear overlaid on the Plan-G map at the airport

e Some codes appear below the “Transitions” divider in the Approaches box.

¢

Approach: HKMO @

l Transitions:

H
} L. MoV

Mombasa

w @

Add to Plan I Clear

Figure 76 Runway 21 ILS Procedure, Mombasa
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The blue line is the track the aircraft should be flying inbound to the airport on the
runway heading, approaching the Final Approach Point (FAP). In the UK, this is
typically between 4 and 7 nautical miles from touchdown, depending on how cramped
the airspace is around the airport. In the USA and Canada, where congested airspace
is less of a problem, this can be 10 or more nm from touchdown.

The red line is the Missed Approach track. If you do not have the runway in sight by
about 2/3rds of a nautical mile before touchdown (200ft above the airfield elevation),
called the Missed Approach Point (MAP), then you must carry out a Missed Approach.
As illustrated, you fly the runway heading outbound for 3 or 4 nautical miles, climbing
to, typically, 1,500 feet above the airfield elevation, then make a rate one turn
inbound back to the beacon (followed in the illustrated case by a “racetrack” holding
pattern, which is flown until cleared by ATC to “continue with the procedure” in which
case you fly the blue trackline once more in the hope of seeing the runway second
time around. Alternatively, and actually more commonly, ATC will vector you to a new
approach, as this saves time overall.

The codes below the “Transitions” divider, in the lower half of the Approaches
window, may be 2, 3, 4 or 5 characters, and are the ICAO identifiers for the transition
points. Typically, if a transition point is an NDB, it will be two letters, a VOR, three
letters and so on.

If you click on one of the Transition Points, then the blue line gains an extra line,
which is the lead in from the Transition point to the Initial Approach Fix (IAF) and
continuing on to the FAP. It may be a “procedural turn”, which is typically teardrop
shaped, or an inbound track from a VOR to the FAP.

Approach: HKMO
VORDME 03 -
VORDME 21

11521

NDE 21

GPS 03
PS5 21

-

e

w @

Add to Plan I Clear

Figure 77 Lead in Procedural Turn to the MOV VOR Transition Point

The transition points are the points at which your en route navigation ceases and you
begin to fly the Instrument Approach Procedure (IAP) or “the procedure” as it is
popularly known. Transition points will always be a VOR, an NDB, or an intersection
(see section 10.3 above for an explanation of an intersection). If the transition point is
an NDB or VOR located on the airfield, (e.g. Manchester) then the procedure will be a
procedural turn. If, as is sometimes found, there is an NDB on the runway extended
centreline and approximately 3 nautical miles from the threshold, (e.g. East
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Midlands), the transition point, and the IAF, will both be the NDB, and the procedure
will start from there.

FSX includes RNAV approach procedures for the USA and Canada, but UK transition
points will almost always be VORs or NDBs.

METAR and TAF

One of the minor miracles of Plan-G is its ability to fetch both the current real world
weather (METAR) and forecast weather (TAF) for any airport within its database which
has an associated weather station. Figure 74 above shows the one-line METAR,
followed by a two-line TAF (although not always two lines, may only be one line or
three). For airports which do not have an associated weather station, or for which
there is no current information, Plan-G displays no weather, rather than use the
nearest available.

Note: the "Download Weather from NWS" option must be set (access via the File tab,
in Options/Weather), for METARS and TAFs to be shown. There is a short delay after
initial startup before weather data is available.

Other Selections

The other selections in the Airport right-click dropdown are: -
o Get Fly-to Heading, Distance and Time

e Move FS Aircraft to Here

e Spot Elevation

e QDM range and Bearing

e Display Range Rings

e Hide range Rings

These options are also available on the Map right-click dropdown and are described in
section 13.1 above which deal with that function.
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14.1.1

14.1.2

FLIGHT PLANS

This section describes the all important procedures for creating, amending, saving,
loading and deleting flight plans. There are two basic methods of creating flight plans:

a) Graphical
b) Tabular

Creating a Flight Plan Graphically

This method is intuitive and fast, and will almost certainly be the choice of most users
for creating a new flight plan.

New Flight Plan
To start, clear the flight plan memory of any existing plan either by

a) Opening Plan-G but not loading an existing Plan, or,

b) Clicking the “File” tab at the top left of the main Plan-G window to open the
drop-down menu, then click on “New Plan”, or,

c) Click the New Plan icon on the Quick Access Toolbar (See Section 6.1 above for
details of the Quick Access toolbar).

If no flight plan is loaded, then there is no visible result from either of these two
actions. The map window will display normal overlay data. However if a Flight Plan is
already loaded, and the map is showing the waypoints and legs of that existing plan,
those legs and waypoints will be erased, but the map location will remain centred on
the same position as for that plan until the User changes the map view with the usual
tools.

Flight Conditions

The “Home” ribbon menu contains the options you need to set up the conditions for
your new flight plan. The selections made here are used to calculate the headings and
elapsed leg times, and are dynamically adjusted in the Flight Plan if you make changes.
These conditions are saved to your new Flight Plan when you click the "Save" or “Save
As" buttons.

Altitude, Cruising airspeed, Wind and VFR or IFR can be entered before or after
creating the plan, but Start Position (e.g. Parking, Ramp, Active Runway) can only be
entered once the start location of a flight plan has been created (see section 14.1.6
below).

Home bata View

DIFR
5':'— Altitude Alr‘speed Wmd's Aircraft Quick Reverse Fr Copy
n Profile Route

Flight Plan

Figure 78 Setting Flight Plan Conditions
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14.1.3 Aircraft Profile

Creating an aircraft profile is an optional feature which influences how Plan-G fits a
flight plan to the aircraft which is going to fly the route. No point in trying to fly a Tiger
Moth over the Alps, or land a 747 on a 700 metre grass strip. You can build a plan
without using Aircraft profiles at all, and make your own judgements on how to
execute the flight with regard to the aircraft’s performance characteristics, or you can
build and save the performance characteristics of your favourite aircraft, and Plan-G
will attempt to tell you whether you can fly from New York to San Francisco in 6 hours
in a Beech Baron (very unlikely).

The “form” for entering the information is opened by selecting the Aircraft Profile icon
from the Home ribbon. All the information required is available on the Internet for
most aircraft, but you may need to adjust some values if Flight Simulator doesn’t
perform to those values (and it often doesn’t).

+l- Aircraft Profile EK J
Aircraft
Manufacturer Model Callsign Tag
[] Turbine / Jet
Reference Speeds
V1 Decision 0 Kts. Vx Best Angle Climb 0 Kts. VsO Stall Dirty o Kts.
VE Take Off Saofety 0 Kts. Vy Best Rate Climb 1] Kts. Vsl Stall Clean o Kts.
VR Rotation 0 Kts. Vfe Flap Extension 1] Kts.  Vme Min. Contral 1] Kts.
Vle Landing Gear 0 Kts. Vne Mever Exceed ] Kts. Vref Landing Speed (1] Kts.
Piston Performance
Climb Cruise Descent
Speed 0 |Kis Econ. Speed 0 Kis, Speed 0 |Kis.
Rate 0 ft/min  Econ. Fuel 0 usg/hr  Rate 0 ft/min
Fuel 0 | usg'hr Perf. Speed 0 Kis, Fuel 0 | usg/hr
Perf. Fuel 0 usg/hr
Taxi 0 |usg Preferred Alf. 0 it @ Avgas ) Jet A-1
Fuel Reference
Max Fuel: o Unusable: o Reserves: 0
I New | I Open | I Save

Figure 79 The Aircraft Profile Form

14.1.4 Departure Airport

First find your departure airport on the map. If it is visible on the current map, then
move the mouse pointer over the airport icon, and right-click. If it is not visible on or
near the current map display, you can zoom out or pan by dragging the map with the
mouse. Alternatively, you can click on the “Find” button on the Home menu ribbon
(far left).

Clicking on the upper half of the "Find" button allows you to search for your starting
airport. If the searched for item exists in your simulator’s database, it will be found,
and the map will centre on it. Search text is NOT case sensitive.

When you click on the ‘OK’ button on the Find Airport window, the map is centred on
that airport.
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Couniry State City
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]

] v
csv

K

=

[ Cancel fe]

[ Add to Plan

9= Find Airport 2 |
Search
ICAQ Code Name City
Waterford
hCAO |Nam |Ci1y lﬁfafc |Cumh~y
EIWF | Waterford | waterford | | Treland

Figure 80 Using the Find Function to Locate an Airport

Select “Start flight plan at airport <ICAO code>". (Plan-G fills in the ICAO four-letter

code for the selected airport).

=enny Bunclody
EIl \
/,/ L'ul Ferns
f LY
/
A Start flight pl t airport EDWF
e art flight plan at airpo
| Show Airport Diagram ¥
Instrument Approaches
Spot Elevation: 112 ft.

{ Show Radial
Mullinavat

wir QDM: Range and Bearing lexiord
Display Range Rings i
Jrtiaw :

A Hide Range Rings

/ Waterf Rossiare
Lock Info Panel Harbour,
- WTD @ o . . hs @
Tram&EBWFE
k

Figure 81 Right-Click Dropdown - Start Flight Plan from Here

14.1.5 Continue to Add Waypoints

You now can add further waypoints which may be any map
feature you wish. If it is an aeronautical feature and you can see

‘J | ! ==

Home

it on your map, simply right-click on the feature and select the \i‘ :
first option ‘Add <Feature> to Plan’. [Find | 5wt Ahif
If you can’t see your next waypoint, then either pan the map [ @ ateport
with the mouse or use the ‘Find’ function on the Home ribbon. (| vor
Clicking on the lower half of the "Find" button drops down a list T el
of objects you can search for: d Er:ﬁ:;:m
e Find Airport. (In MSFS, you can search by ICAO code, airport A Address

name, or city; and in X-Plane, you can search by ICAO code or

Airport name).

: - e . Figure 82 Find

e Find NDB (Search by 3-letter identifier or by partial name). Optigons Dropdown
e Find VOR (Search by 3-letter identifier or by name or partial List

name).

e Find User Waypoint
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14.1.6

Once the feature is displayed on the map, right-click on it and select ‘Add <Feature> to
‘Plan’ from the dropdown.

The Feature can be an airport, an NDB, a VOR, or a User Waypoint. Its name and ICAO
code are displayed in the dropdown menu, so that you know you have selected the
right one. The example below shows the result of right-clicking on the Clonmel NDB
(CML) near Waterford, Ireland.

CML {B

Add MDB CML to Plan
Spot Elevation: 499 ft,

C: Show Radial

g
QDM: Range and Bearing
Display Range Rings
Hide Range Rings

Kily Lack Info Panel

Figure 83 Right-click Dropdown — Add Waypoint to Plan

The map will now show a track line from your start location to the new waypoint, and
the new waypoint will appear in the Plan table when the ‘Plan’ icon is clicked on the
‘View’ ribbon. Continue with each subsequent waypoint in the same way until you
have added your arrival airport. At each step, the track line will update and each
waypoint will be added to your Flight Plan.

Note that waypoints are added to the Plan in sequence, so if you decide to add an
intermediate waypoint after you have “gone past it”, your track line will double back,
which is probably not what you intend. See Section 14.4.3“Moving and Deleting
Waypoints” below for the way to correct this.

If you click on an airport as a waypoint, the second option on the right-click dropdown
is “Select Airport <ICAO> as Alternate”. See section 13.2.2 above for details on adding
an alternate. It is good airmanship, if not mandatory, to always enter an alternate.

Insert an Intermediate Waypoint

If, as many pilots do, you decide your departure and arrival points before looking at
what intermediate waypoints you wish to go to, then you can do this on the map.
Once the basic plan has been created, open the Plan Window if it isn’t already open,
and click on the waypoint of the plan before or after which you wish to add a

waypoint.

c Add airport CAXS to Plan
Insert airport CAXS in Plan before BCO3
Insert airport CAXS in Plan after BCO3

select Alternate Destination
Show Airport Diagram
Spot Elevation: 3,107 ft.
QDM: Range and Bearing
Display Range Rings

Hide Range Rings

Lock Info Panel

Figure 84 Insert Intermediate Waypoint

Page 71 of 128



Plan G User Manual V 3-1.061 October 2012

Then go to the Map and right click on the intermediate waypoint you wish to insert. A
pop-up menu appears which provides two options for inserting an intermediate
waypoint — either before or after the waypoint on the plan which you had selected in
the tabular Plan.

Note that in Figure 84 above, the Plan-G generated user waypoint label BCO3 has been
added to the screenshot to identify the waypoint mentioned in the dropdown menu.
Normally it is not displayed unless the mouse is hovered over the waypoint.

14.1.7 Start Position

A Start Position on your departure airfield can be entered once the Start Location of
your plan has been created. Until then, the ‘Start Position’ icon on the Home ribbon is
greyed out. One leg is defined as a departure location, plus an end location. The end
location can be your first waypoint or, for direct flights, your destination location. You
can of course complete your plan, be it a direct track plan, or one involving a number
of waypoints, and add the Start Position at the end of the process just before saving
the Plan.

If you add a start position in Plan-G and load your plan into Flight Simulator, then
when FS asks if you want to move your aircraft to the departure airport listed on the
flight plan, and provided you click “Yes” your aircraft is moved in FS, not to the active
runway, which is the FS default, but to the start position you selected in Plan-G. If you
are flying online, then this position should be a starting gate or GA ramp, and definitely
NOT the active runway.

Note: To use this option, your plan must be exported to a .PLN file first.

-
4} Set Airport Start Position

GATE SMALL

GATE SMALL

GATE SMALL
|| PARKING 1 RAMP CARGO
| GATE 9 GATE MEDIUM

\ | GATE 8 GATE MEDIUM

GATE 7 GATE SMALL

|| GATE 6 GATE SMALL

Ll [GATE b GATE SMALL 4

Cancel |

Figure 85 Move your Aircraft, but not to the Active!

14.1.8 Vertical Navigation
Building a vertical navigation profile by adding passing altitudes cannot be done
graphically, but requires the parameters to be entered from the keyboard. It can be
done by entering the details in the Plan, once the flight plan route has been completed
graphically. See section 14.4 below for full details.

14.1.9 Notes

Adding notes to a flight plan is carried out from the keyboard. It can be done by
entering the details in the Plan, once the flight plan route has been completed
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graphically. Open the Plan Window. Scroll across to the “Notes” column and double
click the appropriate cell. You can now enter free text to add any important
information for that leg of the route. The cell expands to accommodate the text
entered.

14.1.10 Save your Plan

Once you are satisfied with the sequence of waypoints, passing altitudes and notes in
the Plan table, save the plan as described in section 8.3.

14.1.11 The Reverse Button

14.2

14.2.1

This button automatically reverses the sequence of waypoints in a loaded flight plan
and recalculates the bearings to create a new flight plan for the return trip, assuming
you want to go back along the very same route. The window title in Plan-G will reflect
a new name for the reversed flight plan, and when you save it, Plan-G automatically
changes the name for the new, reversed plan.

Creating a Flight Plan in the Plan Window

Although you may find it less intuitive, Plan-G nonetheless allows you to add, move or
delete waypoints directly in the Plan Window. This could be convenient, for example,
when transcribing a flight plan from a printed form or a handbook.

First click the ‘New Flight Plan’ icon on the Quick Access toolbar to clear any loaded
data from Plan-G. The departure airport must now be chosen in the usual way, by
either right-clicking on its icon, or by using the ‘Find” menu at the top left of the Plan-G
window. Now that there is a single waypoint in the new flight plan, the ‘Plan’ window
will contain a single line containing the departure airport, plus a line in the summary
box below the brown divider bar, although it won’t be meaningful at this point.

Adding Waypoints to the Plan Table

The next waypoint, or the destination airport, can now be entered into the table.
Right-click on the table entry for the departure airport, and select ‘Insert Waypoint
Below’.

4 Insert Waypoint ==
| Airports VORs | NDBs ‘ ISECs User Wpts
| | Eidel

| (02X5  Elroy  Seidel Ranch

| [ONA4  Valley City Kreidelcamp

2MT3  Pennington Weidel/Pvt/

" | CAO7  Pleasant Grove Scheidel Ranch

| |ETIE  Heidelberg Heidelberg AAF
| [FAH5  Heidelberg Heidelberg

[comat ] (ot

Figure 86 Adding a Waypoint to the Plan Table

This pops up an ‘Add Waypoint’ panel, where you can select the type of waypoint
(Airport/VOR/NDB/User Waypoint). The waypoint to be added can be found either by
its ICAO code or by its name. If it exists in the Plan-G database, then as you type,
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14.2.2

14.2.3

14.3

14.3.1

14.3.2

14.3.3

Plan-G will find all relevant entries and display them below the entry line. As you
enter a few letters of the name or ICAO code, Plan-G will display only those entries in
the database containing with those letters. In the example above, the letters ‘Eidel’
were entered which showed a list of airfields, not starting with those letters, but
containing those letters, from which the one required can be chosen.

Once the desired waypoint is found, clicking ‘OK’ will insert it into the Plan table, and
will extend the track line on the Plan-G map to the new waypoint

Notes

Open the Plan Window. Scroll across to the ‘Notes’ column and double click the
appropriate cell. You can now enter free text to add any important information for
that leg of the route. The cell expands to accommodate the text entered.

Save Your Plan
Once you are satisfied with the all the information in the Plan table, save the plan in
the usual way.

Note: that if you export it as a .PLN file for use within Flight Simulator, cross
references, passing altitudes and notes cannot be saved. All these are included in
saved .PLG files. Therefore it is recommended that you save the Plan as a .PLG file first
to preserve all that additional Plan-G data, and then export it.

Right-Click Options in the ‘Plan’ Window

As well as adding new waypoints to Plan table, there are a number of other options for
modifying your plan.

Set This as the Active Leg

Clicking this option sets the 'active' leg for calculating time & distance to next
waypoint. It is only useful if connected to FS and where you may have opened a flight
plan part way through a flight. Setting a new active leg allows you to “pick up” the leg
in the flight on the flight plan which your aircraft is currently flying. Put another way,
(and it is not exact of course) it “sort of” synchronises your flight to the plan. It can
also be useful if

o The pilot misses a waypoint completely, and wants to tell Plan-G to forget pointing
to the last waypoint, but to now help get to the next one, or
e The flight plan has been changed mid-flight, or

e The leg sequencing goes awry in Plan-G for some reason

Centre on Map

If you right click on a waypoint in the plan, the map moves to position that waypoint in
the centre of the map.

Insert, Move or Delete Waypoint

Waypoints can be inserted or moved up or down in the table, or deleted from the
plan. Right click the entry in the table you wish to move or delete, and select the
appropriate menu option from the dropdown. See Figure 87 and Section 14.4 below.
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Flight Plan: Cix Wellesbourne Mountford to Wolverh
| Waypeint | Description Heading
EGBW Wellesbourne Mountford 003=
: o an
EGRQ Walv Centre on Map
Show Airport Diagram
Maove Waypoint Up
Move Waypoint Down
Insert Waypoint Above
Insert Waypoint Below
_— Cross-References..
Start Pos: B \ Insert Quick Snippet...
Insert Snippet file...
Add Alternate
Ross-oniye Delete Waypoint

Set Author

Figure 87 Flight Plan Waypoint Dropdown Options

14.3.4 Cross References

Cross references are useful for defining a waypoint precisely using vector geometry.
For the non-mathematically inclined, it means that any point on a map can be
precisely identified by an angle and distance from a point. You can also get a “fix” if
you have only the angle from two known points relative to a common axis. That
principle is called “Triangulation”. In aviation, the angle is of course the Magnetic
Bearing from the waypoint (QDR) and the common axis is Magnetic North.

In flight, if a pilot tunes in a VOR on his NAV1 radio, then turns the Omni-bearing
selector (OBS) until the CDI needle is centred and the “TO” flag is displayed, and also
observing the DME instrument, the pilot is able to obtain a “position fix” for the
aircraft, which will be, for example 262° TO the VOR (i.e. broadly to the west of the
aircraft) and 22.4 miles from it. In other words, The QDM of the Aircraft to the VOR is
262°.

By selecting a second VOR within range and carrying out the same exercise, the
position fix may be confirmed, or the accuracy of the pilot’ s rough plot on the chart
improved (remember he/she is flying the aircraft at the same time!) Ideally the radials
from the two VORs should intersect as nearly at right angles as possible.

VOR 1

Figure 88 Position fix from two VORs
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In Plan-G, if you select “Cross References”, you can enter two radio Navaids in the
dialogue box which opens. Click the “Add” button for the first cross reference then
select the table you wish to search — either VOR or NDB, by clicking the appropriate tab
at the top of the window. Now select a Navaid, either by typing in the ICAO Identifier,
e.g. BPK for Brookmans Park VOR, or pick the one you need by scrolling down the (very
long, worldwide) database of Navaids displayed.

The vector lines are drawn on the map, and the bearing TO the Navaid (QDM remember)
and distance are shown in the flight plan in the Information Window, and included in the
Pilot’s Log (PLOG). To use this information to arrive at the waypoint, you need to turn
the Omni-bearing selector (OBS) until the “TO” flag is displayed, and the CDI needle is
centred. Note the bearing indicated at the top of the instrument. Turn the OBS again
until the Plan-G QDM is indicated and fly a closing heading until the CDI needle is again
centred. Observe the distance on the DME instrument and turn onto the QDM heading,
keeping the CDI needle centred until the Plan-G distance is displayed on the DME. Then
you will be at the waypoint. For example: the Plan-G QDM is 262° and you are flying
heading 030°. Turn the OBS to 262°, turn the aircraft 90° to it — 352° and then turn
heading 262° as the needle starts to centre. (see section 13.1.5 above for an
explanation of “Q codes”).

When using two NDBs for cross references, Plan-G is a bit smarter than real world NDBs,
because it provides distance information, which real world NDBs do not. If you use two
NDBs in the real world your fix is provided entirely by the intersection of the two
indicated ADF bearings.

Warning: Make sure if you enter an ICAO code that you have selected the correct
waypoint type. In the flight plan below, someone selected “CAM” for the Cambridge
NDB, but from the VOR table, and got a silly result - 2,895.3nm! The CAM VOR happens
to be near Schenectady, New York State, USA, not near Cambridge, England! It is the
CAM NDB which is on Cambridge (UK) Aerodrome, and which makes a good cross
reference for Duxford!

Flight Plan: VFR Crowfield to Cranfield
|Wuy'pa|'nr Dascription Heading °M | Time | Dist (nm) | Track ®*M | Track °T | &/S (kts) | MEF | Passing Alt | ATA | XRefl XRef2
EGS50 Crowfield 004° 1] 0 000° 000" 100 0

ESSU Duxford 267° 22 364 267" 263° 100| b0OO CAM BKY
292° 2895.3 nm | 205° 6.6 nm

@

EGTC Cranfield a7i® 16 27.56 271° 269° 100| 600

Figure 89 The Wrong CAM!

14.3.5 Quick Snippet

This is a time saving feature for inserting intermediate waypoints in a tabular Plan.
Open the Plan window and right-click the waypoint AFTER which you wish to insert the
intermediate waypoints and select the ‘Insert Quick Snippet’ option. The Quick
Snippet dialogue opens. Enter the identifier of the waypoint(s) you wish to insert,
separated by space characters as shown in Figure 90 below. The waypoints will be
inserted in your Plan, and the map updated, with the new waypoints. If you try to
enter a text string other than the waypoint identifier, such as its name, or if you
separate the waypoints by commas, dashes or any other character, Plan-G complains
by turning the dialogue box pink. However, it will not complain if you enter them in
the wrong order — it is up to you, the user, to get that right.
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1 Quick Snippet [=]

Route:

EGHS EGTU |

[ Cancel | [ oK |

Figure 90 The Quick Snippet Dialogue
*} Quick Snippet =2

Route:

EGHS.EGTU

Figure 91 Entry Text Format Error Alert

L Dulverton = 2
h / Taunton., -~ - N T
wellington —"
e C— Stalbgbige . COM &
L b S5 éturmirster  Fpia
gh Tiverton i Newtun_\
4 Ellrandfnrdfg
Flight Plan: VFR Popham to Perranporth
Waypeint | Description Heading ®M | Time | Dist (nm) | Track °M | Track °T | 6/5 (ki
EGHP Popham 004° 0 o] ooo® ooo® 1q
EGHS Henstridge 258° 26 44 268° 254° 10
EGTU Dunkeswell 262° 20 341 262° 258° 14
ESTP Perranporth 250° 48 80.6 260° 247° 1q

Figure 92 The Modified Route via Henstridge and Dunkeswell

Some third party scenery developers sometimes add non-standard identifiers to their
products such as 4 character codes for NDBs. These are not recognized in Plan-G.

There is technically no limit to the length of the inserted text; the number of
intermediate waypoints you can add. The limitation will be one of practicality.

14.3.6 Insert Snippet File

If you have exported a flight plan as a snippet (See Section 8.4 above) , it can be
inserted into other flight plans. Snippets can be any length, any number of waypoints,
but again, the limitation will be one of practicality.

Taunton

Wellington —

=

Figure 93 Part of a Direct Route Popham to Perranporth

Open the Plan window and right-click the waypoint AFTER which you wish to insert the
intermediate waypoints and select the ‘Insert Snippet File’ option. The
Documents\Plan-G Files Folder window opens. Select the file you wish to insert and
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14.3.7

14.3.8

14.4

14.4.1

14.4.2

click ‘Open’ at the bottom right of the window. After a slight pause, the Folder
window disappears and the Plan Window will be displayed with the waypoints from
the snippet inserted in your Plan, and the map updated with the new waypoints,
exactly the same as shown in Figure 92 above.

Add Alternate
This option is described at section 13.2.2 above.

Set Author

If you want to be recognised as the world leader in creating Plan-G flight plans, then
click this option and enter your name in the dialogue box. Now when you send your
plans to others, your fame will go with you.

Modifying Existing Flight Plans
With a previously-created flight plan opened in Plan-G, you can either: -

e Add one or more waypoints to the end of the existing chain of waypoints,

e Insert a new waypoint between two existing waypoints.

Adding a New Waypoint to the End of a Plan

Adding a new waypoint to the end of the sequence is just a matter of right-clicking it
and selecting "Add <waypoint ID> to plan"”. You then "Save" or “Save As" the changed
flight plan, as described above.

Inserting a New Waypoint

Inserting a waypoint between two others in a flight plan must be done in the Plan
Window. Open the Plan window and right-click on the entry above or below which
you wish to insert a new waypoint. Select either ‘Insert Waypoint Above’ or ‘Insert
Waypoint Below’ according to where you wish to insert the new waypoint. This pops
up an ‘Insert Waypoint’ dialogue, where you can select the type of waypoint to be
inserted (Airport/VOR/NDB/User Waypoint).

Flight Plan: CXA Pitt Meadows to McBride )
| Waypoint | Description | Heading °M | Time | Dist (hm) | Track °M | Track °T | 6/S (kts) | MEF | Passing Alt | ATA | XRefl| XRef2 | Notes
CYPK Pitt Meadows 341¢ Q 0| o000° 000° 100 o
CBK6 Quesnel Lake asa° 125 207.5 358° I 100| 9000
BCO3 BCO3 009° 11 17.8 009° 031° 1001 8000
= 8 137 048° 068° 100 8000
Centre on Map & &
CXAI 4 61| 035 055 100 9800
11 (D WMeueWeypoint Up 12 196/ 007° 026° 100/ 9800
CAV: Maove Waypoint Down 4 1.2 3167 335° 100| 9400
Insert Waypoint Above
Stan Insert Waypoint Below s, Alfitude: 10800ft. (Suggested Altitude 10800F+)  Total Distance: 271.9 nm  Total Time: 2:44
TAS Renameqlnsertanewwaypoint below this one. ‘
Cross-References., 1
S Insert Quick Snippet...

Insert Snippet file...
Add Alternate
Delete Waypoint

Set Author

Q&@ )

cYeP

Figure 94 Inserting a Waypoint
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14.4.3

1444

14.5
14.5.1

14.5.2

The waypoint to be inserted can be found either by its ICAO code or by its name. If
the desired waypoint exists in the Plan-G database, as you type, Plan-G will find all
relevant entries and display them below the entry line. As you enter a few letters of
the name or ICAO code, Plan-G will display only those entries in the database, not
starting with those letters, but containing those letters, from which the one required
can be chosen.

Select the one you want (often there will be only one if you enter a unique identifier)
by clicking on it to highlight it, then click ‘OK’. Clicking ‘OK’ will insert it into the Plan
table, and show it on the Plan-G map, and will move the track line to match the order
of entries in the table.

Moving and Deleting Waypoints

You can of course move waypoints up or down in the table, or delete them. See
section 14.3.3 above for details.

Save Your Edited Plan

If you have edited your Flight Plan by adding or inserting new waypoints, for example,
and wish to keep the original as well, then go to the File Tab and select “Save As”,
select either a .PLG or a .PLN file, and give the modified plan a new name.

Vertical Navigation Profiles

User Defined VNAYV Profile

You can build a custom vertical navigation (VNAV) profile in Plan-G if you wish. At key
waypoints, where altitude is critical, such as controlled airspace boundaries or high
terrain, you can fix the altitude to fly. Load a flight plan and open the Plan Window.
Scroll across to the right of the plan to the “Passing Alt.” column. Double click the
appropriate cell in the column and enter the desired altitude. Enter the value without
a comma separator for 000s, although if you do include a comma separator, Plan-G
will remove it.

If you now open the Plan Elevation window, you will see your Vertical Navigation
Profile displayed as a solid orange line. If the Plan Elevation Window is open when you
enter passing altitudes, the VNAV profile is not displayed until you close and reopen it.

Default VNAYV Profile

If you choose not to build a vertical navigation profile, Plan-G builds a default one
anyway, based on the diagram below.

Plan-G calculates a Top of Descent (ToD) point based on your altitude and true
airspeed. For example, if you are flying at 120 knots (2nm per minute) at 3,000ft, and
the rate of descent is set at 500ft per minute, then to descend to 1000ft will take 4
minutes, in which time you will have travelled 8 nautical miles. The target position is
normally 1000ft above the destination and 3 miles before it —i.e. at circuit height and
in a comfortable position to join the visual circuit. So the ToD point in this case would
be 11nm from your destination.
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One minute before the ToD point an alert sound and popup message, “One minute to
VNAV Profile” is displayed. In the example above, this would be 13nm before
touchdown.

| “One minute to VNAV profile”
\

\ - Top of Descent
Flight Altitude & "
™,

S\ - 500 ft/min
\_ - Glide Slope +- 1 deg.

“500 ft. to target altitude” |——

Target

Circuit Height — 1000 ft
3nm

%
Runway

Figure 95 Vertical Navigation Profile Diagram

A second alert sounds 500ft above the target altitude, and a further popup “500ft to
target altitude” is displayed.

The vertical navigation profile parameters are all user configurable via the File tab, in
Options/GPS Panel, see section 8.7.6 above).
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15

151

USER WAYPOINTS

Plan-G builds an internal database (PlanG_FSX.sdf or PlanG_FS9.sdf) of airports and
navaids based on a scan of the FS scenery configuration file. User Waypoints together
with official “Visual Reference Points” are contained in a separate database within
Plan-G, namely, UserWaypoints.sdf. Plan-G includes a large number of pre-defined
User Waypoints, as shown in Figure 96 below and you can also add your own.

<} Manage User Waypoints =& = o
Category Narme Tdentifier Latitude Longitude Elev. (ff) Variatior D%dm
pPOT Alrcraft Carrier Fleat Fleet -27.20212173 |153.6356691 |0 3488 [= 4
POT Yandi Mine 2 YANDIZ 2273000744 | 1101038132 1972 |358.33 = /
Gbstacle 2nd Severn Bridge (Joins EGTG201) [New Severn | 5157086182 |-2.691502094 |0 341 o
Glider aaatest aca 56.28529739 1054361343 |82 368.92
POT Abbot Pt Coal Facility Abbatt pt -19.87974548 [148.0805969 |0 35182
Obstacle Aberthaw EGFF2014 513857193  |-3.402817011 |0 3.65
Airstrip Abilbah Abilbah -24.71198273 [144.2910919 | 928 35189 [
" Airstrip Adaminaby VADY -35.99745178 [148.7958679 3888 [347.47 Gurkiagai
Airstrip Adelong Adelong -35.31274414 |148.0798645 |1299 347.97 /
T EGeT WaTeR TR TR ZUTETTS e eOZTeeT T2
‘ Obstacle Aintree 1710902 5§3.45563889 |-2.957067013 |49 3.88
-;V: VRP AINTREE RACECOURSE LIVERPOOL |53.47267151 |-2.939167023 |49 3.87
Airstrip Airey's Tnlet ATREY -38.46628052 144.062088 |02 34857 ‘\:rmuu
Obstacle Airth (Joins 150A010) 1504007 5606742859 |-3.741899967 |3 479 .
Airstrip Albany Park YAPK -13.08650112 (1310366364 |594 35644 T f
Obstacle Albury Park 230C387 5120808029 |-0.476816697 | 400 25 Adelang
VRP ALDERBURY OLD SARUM 510423317 |-1.725667 253 2.94 g Elev: 1299 ft.
< il | » \
TE
Tmport...

[ — 7

Figure 96 The User Waypoint Database

Creating User Waypoints

You can create custom waypoints anywhere you like on the map without restriction.
This is particularly useful for VFR flight where towns, lakes, hills and other features are
required as points of navigational reference.

Right click the map at the point where you want to create a user waypoint to display
the dropdown menu which includes the Create User Waypoint option.

R AVE
AVE

X
Iﬁ:}irj_ulu

Aboriginal
Community

Create User Waypoint

QDM: Range and Bearing
Display Range Rings
Hide Range Rings

Lock Info Panel

Figure 97 User Waypoint Dropdown

Click the Create User waypoint option and a dialogue window opens for you to enter
the details.
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User Waypoints 2
7 Point of Interest v|
MName
The Olga Hills
Identifier Elevation  Variation
Olgas [::::] -4.39

{Ontional}

MNotes  (bisslaved on the man info apus. Max 50 chars.}

Almost as spectacular as Ayers Rock (Uluru)

Figure 98 Create User Waypoint Dialogue

Enter the waypoint name and an identifying code - which can be up to 8 characters in
length. The magnetic variation (MagVar) at that point and the Latitude and Longitude
are automatically added by Plan-G, but you can edit them to fine tune a waypoint
position to an exact spot if your mouse clicking isn’t so accurate.

If the appropriate DEM files are installed (as described in Section 12.3 above), Plan-G
will automatically fill in the Elevation for the new User Waypoint.

Click “OK” to save the waypoint.

AYE AYE
YAYE
Yulara
e
W
o
utitjulu
Aboriginal
Clgas Cornmunity
The Olga Hills
Almost as spectacular as Ayers Rock (Uluru)

Figure 99 User Waypoint Created

The waypoint symbols which are shown on the map depend on the type defined in the
dialogue (Figure 98 above). Figure 99 shows that the Olgas are a Point of Interest

€73 Airstrip @0 Disused 7 poI [ slider
(H) Helipad @ Location © vrp [ Useri

@) water A Obstacle A& TFR [ Userz
User Waypoints

Figure 100 User Waypoint Type Symbols

The waypoint is saved in the User Waypoint Database which can be manipulated in a
similar way to a spreadsheet (see Section 11.4 below). Go to the ‘Data’ tab, click on

‘Manage User Waypoints’ to open the User Waypoint Database as shown in Figure 101
below.
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‘points =8 I=R ()
Category Narme ’ Identifier Latitude Longitude Elev. (f1) Variation Tag Notes
Disused Tealing Disused Tealing 56.52050018 -2.96866703 367 ~5h UK -
Obstacle Tees South (Joins 171A518) Tees S 54.5929184 -1.167016983 3 3.36 UK
Airstrip Teewah Teewah -26.3142662 163.0446167 3 349.12 |OZ QLD |S5E Lake Cootharaba
Obstacle Telecom Tower BT Tower 51.51958084 -0.1366667 105 242 UK
POL Temple of Karnak Luxor 25.71858978 32.66723419 240 356.99 Egypt
Disused Templeton Disused Templeton 5175817108 -4.75283289 256 427 UK
|| bisused Tempsford Disused Templesfd 52.16617044 -0.259666711 171 257 UK
r e = 2 2 - =
pOI The Olga Hills Olgas -25.3238730040447 130.664270019531 |0 -439  |OZ Almost as spectacular as Ayers Rack (Uluru)
poI The Pyramids Pyramids 29.97586632 31.13121986 128 356.75 Egypt
PUL T Tnres JIsrer SIS TR =92 00 CTOT OO STHESST ZIT BiETs "
! VRP THELWELL VIADUCT MANCHESTER |b53.38766098 -2.603499985 72 3.08 UK
l Airstrip Theodore YTDR -24.99181657 160.0930634 719 350.28 |OZ QLD |17-35 2500': asphalt
Obstacle Thetford Thetford 52.44271851 0.72025001 85 224 UK =
i Airstrip Thistle Island Thistle -3b.02444458 126.1812897 167 352.88 |OZ5A Dirt
Disused Tholthorpe Disused Tholthorp 54.10266113 -1.256000042 79 33 UK
VRP THORNBURY FILTON 5160667038 -2.5617667055 249 335 UK -
« il v

|
p— p—

Figure 101 User Waypoint Added to Database

15.2 Adding a New User Waypoint to a Flight Plan
Right click the new User Waypoint on the Map, and the Name of the waypoint will be
displayed as the first item on the dropdown menu, as ‘Add User Waypoint The Olga
Hills to Plan’.

=
AYE AYE

YAYE
= A
Add User Waypoint The Olga Hills to Plan
Edit User Waypoint
Delete User Waypoint from Database
QDM: Range and Bearing
Display Range Rings
Hide Range Rings

Lock Info Panel

Figure 102 Add User Waypoint to Flight Plan

Select this option and the waypoint is added to the Flight Plan. The new waypoint is
added as the last item. Right click on the flight plan to display the dropdown menu
which allows you to move the new waypoint into its correct position. The track line
will adjust accordingly. (See section 14.4.3 above for more on editing flight plans.)

15.3 Modifying User Waypoints

You may wish to move a waypoint slightly, change its name or identifier. If you right
click on the new waypoint, the dropdown has three new items which are reasonably
self-explanatory. If you select “Edit User Waypoint” the Create User Waypoint
dialogue is again displayed, although now with the window title “Edit User Waypoint”
at the top. You can make changes directly in the text boxes, including moving the
waypoint by changing the Latitude and/or Longitude values.

If you rename a waypoint that is included in the current flight plan, the plan will be
updated to reflect the change. Any plan that is not currently open will, of course, not
be updated.
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15.4 Deleting User Waypoints
To delete a User Waypoint, right click on the new waypoint, and select ‘Delete User
Waypoint from Database’ from the dropdown menu. The waypoint is immediately
removed from the database, and the map, but not from the current flight plan or its
track line on the map.
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16.1

AN EXAMPLE FLIGHT PLAN

Much of Plan-G is intuitive. You don’t need this comprehensive manual at all. So, for
those who don’t have time to read manuals, but just want to get going, here is a
worked example of a short VFR flight across some of England’s most beautiful and
famous landscapes. It introduces as many features of Plan-G that can be reasonably
packed into a short 115 mile flight.
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= | LoE= Plan-G3: VFR Carlisle to Liverpool John Lennon = = =
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Figure 103 Carlisle to Liverpool — The Route

Preparation

Just as in the real world, there is a significant amount of preparation required before
flight. Of course we will start by creating a flight plan in Plan-G.

1. Open Plan-G and on the Home Tab, click “Find”.

Select Airport from the dropdown and enter EGNC in the ICAO Code box.
Carlisle will be highlighted. Click OK.

Right-click the airport icon and select “Start Flight Plan at airport EGNC”

vk N

Now set up the flight conditions. Open the Home Ribbon by clicking the Home
tab, and then click Altitude, and set 4,000 feet.

o

Select Airspeed, and enter 100 knots for the default Cessna 172.

7.  Now that you have a Start Location, you can now add a Start Position for your
aircraft at Carlisle. In FS, you have already selected PARKING 1 - RAMP GA
SMALL, so from the Home Ribbon, select “Start Position”. From the options
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shown in the pop-up “Set Airport Start Position” window which appears, select
PARKING 1 -- RAMP GA SMALL again, and click OK.

The Scenic Route

You have established the flight pre-conditions and now it is time to plot the route to
Liverpool.

1.

Find the Wigton VRP to the south-west of Carlisle. Right click and select “Add
User Waypoint CARLISLE WIGTON to the plan. (Wigton is a Visual Reference
Point and included in the default Plan-G database, although it is called a User
Waypoint).

If you do not have photographic scenery for the UK, Wigton (the town) will not
be obvious, so you may wish to add a Cross Reference to it from Dean Cross VOR.
Right-click the Wigton VRP symbol and select ‘Set Waypoint Cross References’

In the Cross reference window, click ‘Add’ for the first point, and enter “DCS” in
the entry box. Select the Dean Cross (the only) entry, and click OK

Observe the Cross reference red line from Wigton to Dean Cross VOR. In the
plan, note the bearing and distance (2312 8.7 nautical miles). When you fly the
route, you can compare your present bearing and distance from Dean Cross VOR
to find which way to fly to arrive overhead Wigton.

From Wigton, you will fly over Keswick and admire the beauty of the Lake
District. You need to create a User Waypoint for Keswick (pronounced Kezzik, by
the way). You will find Keswick to the south east of Dean Cross, on the south
side of Bassenthwaite Lake and just north of Derwentwater.

At zoom level 12, you will see the town clearly. Right click on the town name
Keswick shown on the map, and complete the User Waypoint Dialogue box.
Check that “Location” is set as the waypoint type. Enter Keswick Town in the
Name box, and KESWIK in the Identifier box. In the tag box, you could enter your
initials to indicate that it is one of your user-created waypoints.

Click OK and observe the small green waypoint circle appear on the plan. Ifit
doesn’t show, drag the map a small amount and it will be displayed as the map
refreshes.

Now you can add another leg to the plan. Right click your new waypoint and
Select the option “Add user waypoint KESWIK Keswick Town to the Plan”

Note that the newly added track line goes over some impressive looking high
ground. Itis in fact Skiddaw, at 3,052 feet, the 4t highest mountain in England. If
you have downloaded the Digital Elevation Model (DEM) tiles from the NGDC
'GLOBE' website at http://www.ngdc.noaa.gov/mgg/topo/gltiles.html you can
now look at what this means in terms of vertical navigation. (See section 12.3 for
details of DEM.) If you haven’t downloaded the DEM tile for the UK, you really
ought to. It adds a great feature to Plan-G. You need tile B, filename b10g.gz
which covers 90% of the UK.
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13.

14.

15.

16.

So you now have the DEM info installed. Open the View Ribbon, by clicking the
View tab, and tick the Plan Elevation Tick box at the top left of the ribbon.

Whoa! That is some mountain (in UK terms anyway) 24 nautical miles en route.
Note the Maximum Elevation Figure (MEF). You will now realise why the planned
altitude was 4,000 feet.

Now zoom the map to Level 14. The names of the Lakeland peaks are visible at
that scale. Move the cursor and observe the Latitude and Longitude changing on
the status bar at the bottom. Find the location which is at Latitude N54¢ 27’ 15”
Longitude W0032 12’ 42”. You will see the name Scafell Pike — England’s highest
mountain at 3,210ft. Create another user waypoint at the top of the mountain.
Call the waypoint Scafell Pike, with the Identifier SCAFLPK. The elevation of your
waypoint should be 3,100 feet. If you have the downloaded the DEM files, this
value will already be set in the elevation box by Plan-G.

Plan Elevation =]

-
Cix Carlisle to Liverpool |ﬁ‘

_'_;_.\ '
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Distance (nm)
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o MEF
W Ground

Figure 104 Over the Lakeland Hills

A